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Overview 
Welcome to the Deltek Budgeting & Planning (renamed to “Deltek Planning” as of September 2018) 7.0 
General Availability Release Notes.  

For the version 7.0 release, Deltek Budgeting & Planning has been fully integrated into the Costpoint 
framework and interface. 

If you are a Costpoint customer, you will find yourself already familiar with the navigation, toolbars, and 
basic screen functionality. 

If you previously had a stand-alone version of Budgeting & Planning (Planning) and did not use Costpoint, 
you should first familiarize yourself with the Costpoint software prior to using the new version. See 
“Available Documentation for this Release” on page 2 for a complete list of the training documentation 
available with this release. 

Using This Guide 
These release notes contain a summary of the following: 

 Available Documentation for This Release – This section lists other guides available to you.  

 Enhancements Related to the Initial Integration with Costpoint – See this section to learn 
about impacts to Budgeting & Planning due to the initial integration with the Costpoint 
architecture. See page 8. 

 Changes Major Enhancements – See this section to learn about later structural changes, 
including the addition of a new, separate Planning domain to house all of the Budgeting & 
Planning applications and the redesign of Proposal Budgeting to New Business Budgeting. See 
page 15. 

 Enhancements (August 2018 – Present) – Refer to this section to learn more about the latest 
Planning features following the creation of the new Planning Domain. Enhancements during this 
period include the following: 

Module Enhancement Date Page# 

Organization 
Budgeting 

N/A   

New Business 
Budgeting 

Import New Business Budgets 
from Excel Added to New 
Business Budgeting 

June 2019 25 

 Other New Business Budgeting 
Enhancements 

July 2019 28 

Project Budgeting Budget Labor Hours by GLC or 
PLC 

August 2018 29 

 Manage Cost Rates August 2018 30 

 Project Labor Category Subtask 
Updates 

August 2018 31 
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Module Enhancement Date Page# 

 Labor Report Updates August 2018 31 

 Project Budget Security Applied 
to Import of Budgets/EACs 

October 2018 32 

 Updates to Labor Hours 
Analysis (CPT5, BPT5, PPT5) 
and Labor Cost Analysis 
reports (CPT6, BPT6, PPT6) 

January 2019 32 

 Import GLCs/PLCs from Excel February 2019 33 

 Ability to Create Budget From 
EAC Added to Project 
Budgets/EACs 

May 2019 34 

 Rollup Applied to Project 
Budgets/EACs 

May 2019 35 

Resource Planning Reschedule and Reassign August 2018 36 

Administration Project Budget Security Applied 
to Project Budgets/EACs 

August 2018 37 

 Project Budget Security 
Enhanced 

August 2018 38 

 Vendor Employee 
Enhancements 

August 2018 39 

 Import Vendor Employee 
Budget/EACs from Excel 

August 2018 40 

 New Period Rate Option for 
Calculation of Effective Rates 

October 2018 41 

 Display Variances in Favor of 
Budget or Actuals 

December 2018 43 

 Update to Configurations 
Settings (MAM10) 

April 2019 46 

 

 Enhancements through July 2018 (Pre Planning Domain) – Refer to this section to learn more 
about the enhancements made to Budgeting & Planning from the initial version 7.0 release 
through July 2018, the last update preceding the release of the Planning domain in August 2018. 
For more information on these features, see page 49. 
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Continuous Delivery Model 
With this release, Budgeting & Planning has moved to a "Continuous Delivery Model" where we will 
release new features and enhancements incrementally on top of Budgeting & Planning 7.0 without 
requiring customers to upgrade to a major, minor or maintenance release as often.  

New enhancements will be made available through DSM after development and testing are complete. 
These software changes can be applied in the same way that hot fixes, cumulative updates, and 
regulatory updates are currently applied, through a combination of system jar and application level 
changes.  

Some features may require a new license, some may be enabled through a control/configuration setting, 
and others, such as an increase to a field size in the database, will be available once the changes are 
applied. 

 

 

Note: Deltek Budgeting & Planning was rebranded as “Deltek Planning” in August 2018, when the 
applications were consolidated into an entirely separate domain within Costpoint, as described in 
detail under Planning Domain Created on page 12 of this document.  

Descriptions of features within this document are organized according to whether they were 
implemented before or after the release of the Planning Domain. 

Note: For more information on the Costpoint Continuous Delivery model you may refer to KB article # 
81289, or see DeltekCostpoint711ContinuousDeliveryModelWhitePaper.pdf, available from DSM. 
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Available Documentation for this Release 
This section describes all the documentation available for this release.  

Documentation in this section is broken down by category, as follows: 

 User Basics Documentation – Guides and documents listed in this section are intended for all 
users who are unfamiliar with the Costpoint interface.  

 Technical Documentation - Guides and documents listed in this section are intended for 
Budgeting & Planning administrators.   

 

User Basics Documentation 

Getting Started Guide with the Interface and User Basics 
The Deltek Costpoint Interface Getting Started Guide contains updated information about the Costpoint 
interface and application functions, with tips for navigating through Costpoint.  

Use this guide as a starting point for learning about the Costpoint interface. There are many notable 
differences between version 7.0 and earlier versions of Budgeting & Planning, because the application 
now resides within the Costpoint framework. Costpoint was previously used in conjunction with Budgeting 
& Planning, but they were separate applications with distinct interfaces.  

Before you begin using the version 7.0 screens, you should first familiarize yourself with the interface 
basics. The table below describes key areas of the guide. 

Document Name Description 

Global Menu and Toolbars The Global Menu provides easy access to 
commonly used functions, so you can carry 
out your tasks quickly and efficiently. Each 
menu item drills down to reveal options that 
are applicable to an open application/task or 
active window.  

Use the items in the Toolbar Menu to save 
work to the database, clone records, refresh 
the current application, manage printing tasks, 
and many other functions. 

To learn more about the Global Menu and 
Toolbar, see Deltek Costpoint Interface 
Getting Started Guide. 

Domains and Modules Costpoint is organized into five program areas, 
or domains. The Navigation screen displays 
these domains in the stack on the left side. 
These domains are further categorized in a 
series of three panes. Starting from left to 
right, you can navigate from the highest-level 

Note: Except where noted, all the user guides and quick reference guides described below are 
available for download from the Deltek Customer Care Connect site. 
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Document Name Description 

program domain down to the desired 
application. 

Each domain in Deltek Costpoint is subdivided 
into modules, which are displayed on the left 
pane next to the domain list. When you select 
a module, the list of application groups 
displays on the second pane. 

You only see those domains, modules, and 
applications to which you have access rights. If 
you have questions concerning 
access/permissions, please contact your 
administrator. 

Ease of Access Features Costpoint has a Lookup and Autocomplete 
feature that makes it easy for you to create 
new records and find the data that you need. 

User Preference Functions Costpoint has a Change Default Period 
feature which you can use to change your 
default fiscal year, period, and subperiod for 
the current module. It also has a Maintain My 
Menu feature which you can use to create a 
custom user menu for quick access to your 
most frequently used screens, including the 
Manage My Desktop screen.  

 

Quick Reference Cards 
A Quick Reference Card displays a visual presentation of summary information about a system feature or 
screen.  

Currently, four quick reference cards are available: 

 User Interface – This card contains information about the Costpoint interface and navigation. 

 Shortcut Keys and Toolbar Icons and Buttons – This card lists the shortcut keys and icons 
available in Costpoint. 

 Query and Lookup – This card shows you how to use the Query and Lookup features. 

 Views – This card explains the differences between Table View and Form View. 

You can also obtain these Quick Reference Cards from the Deltek Software Manager.  

Costpoint Planning Learning Aids 
The Deltek Learning Zone (DLZ) provides several options for self-paced learning.  

To access the DLZ from within Costpoint: 

1. Click Help »Costpoint Information Center. 

2. Select Deltek Learning Zone. 

https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=0CA4F657-1A6A-4955-948F-A8595C5E6E70
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=2820EB22-7E98-4065-89CE-EC228062F259
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=0C1FD518-9BC8-44B4-95CD-B42D6106C68F
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=29A58058-9399-40A7-B617-A96EF5EB7051
https://deltek.csod.com/client/deltek/default.aspx
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3. From the list of products, click the Costpoint icon . 

4. On the “How Do You Want to Learn” page, scroll down through the Learn by Workflow section. 

5. Select Understanding Costpoint Planning.   

6. Under Learn on My Own, click Costpoint Planning Series and choose from the following self-
paced learning videos: 

 Insight 2018 Prepare a Project Budget  

 Planning Domain Overview  

 Project Budgeting  

 Project Budgeting Reports  

 Resource Planning  

 Organization Budgeting Reports 

 Rate Processing/Reports 

 Plug Processing and Reports 

Additionally, an older series of videos is also available to you. The information described in these videos 
is current and can help you understand the differences between version 6.1 and version 7.0. However, 
because they are older, they do not reflect the recent updates to the Costpoint user interface. 
Additionally, the menus and navigation do not reflect the new Planning Domain. To review these videos, 
click here. 

Menu Maps 
If you are moving to version 7.0 from version 6.1 or earlier, the Budgeting and Planning Menu Maps can 
help you locate your applications. DeltekBudgetingandPlanning70MenuMapping61to70 and 
DeltekBudgetingandPlanning70MenuMapping70to61 can be downloaded from the Deltek Software 
Manager. 

 6.1 to 7.0 Menu Mapping –– The left column of this Menu Map lists the version 6.1applications in 
menu order. Find the application you want to open. The second column displays that application’s 
menu path in version 7.0.  

 7.0 to 6.1 Menu Mapping –– The left column of this Menu Map lists the version 7.0 applications 
in menu order. Find the application you want to open. The second column displays that 
application’s menu path in version 6.1 

Technical Documentation  
Costpoint Planning 7.0 is built on the Deltek Costpoint platform. As a result, it inherits and benefits from 
the standard features of Costpoint and shares the available technical guides. 

Installation Guides  
There are several guides that will help you in the installation of Budgeting & Planning 7.0 and they are: 

 DeltekBudgetingAndPlanning700UpgradeInstallationForMicrosoftSQLServer.pdf 

 DeltekBudgetingAndPlanning700NewInstallationForMicrosoftSQLServer.pdf 

https://education.deltek.com/web/budgetingplanning/7/index.html
http://ashapt535vs:82/DeltekBudgetingandPlanning70MenuMapping61to70.pdf
http://ashapt535vs:82/DeltekBudgetingandPlanning70MenuMapping70to61.pdf
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=D45EFCAC-8D0D-448C-9760-7EF1790F7CB0
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=8E457A1B-7440-44A4-BCE3-B76A02676FEF
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Post-Installation Guides and Worksheets 
The table below contains the list of post-installation configuration guides and worksheet available for 
Costpoint Planning. 

Document Name Description 

DeltekBudgetingAndPlanning700PostInstallati
onConfigurationGuide 

This document provides instructions for post 
installation configuration of Deltek Budgeting & 
Planning 7.0.0 software. 

DeltekCostpointPlanningCloud700PostInstallat
ionConfigurationGuide 

This document provides instructions for post 
installation configuration of Costpoint Planning 
Cloud. 

Deltek Budgeting and Planning 7.0.0 Post 
Installation Configuration Settings Worksheet 

This worksheet describes configuration 
settings and is intended for distribution to 
accounting personnel by System 
Administrators. 

Deltek Budgeting and Planning 7.0.0 Post 
Upgrade Configuration Guide 

This guide is for System Administrators. It 
describes additional post-upgrade 
configuration tasks. 

Deltek Costpoint Planning Cloud 7.0.0 Post 
Upgrade Configuration Guide 

This guide is for System Administrators. It 
describes additional post-upgrade 
configuration tasks for Costpoint Planning 
Cloud 

Deltek Budgeting and Planning 7.0.0 Post 
Upgrade Configuration Settings Worksheet 

This worksheet describes configuration 
settings and is intended for distribution to 
accounting personnel by System 
Administrators. 

Other Costpoint Technical Guides  
Budgeting & Planning 7.0 is built on the Deltek Costpoint platform. As such, it inherits and benefits from 
the standard features of Costpoint and shares the available technical guides.  

The guides and documents are described in the table below and can provide administrators with 
additional information about Costpoint features and benefits. These documents can be downloaded from 
Deltek Software Manager (DSM).  

To access DSM, go to https://dsm.deltek.com. 

Document Name Description 

Deltek Costpoint 7.1.1 Configuration Utility This document describes how to use the 
Costpoint Configuration Utility, which helps 
Costpoint administrators perform the most 
common configuration tasks. 

https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=190F2FC7-C75C-4C5E-9C2D-1132AB727D06
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=190F2FC7-C75C-4C5E-9C2D-1132AB727D06
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=AB5E23DF-E132-4E4B-8BB8-8960B05873E8
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=AB5E23DF-E132-4E4B-8BB8-8960B05873E8
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=D429128B-CB63-449D-B583-BE16A7CA76B1
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=D429128B-CB63-449D-B583-BE16A7CA76B1
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=55AB9367-2A65-42E2-AFE4-D9B292FB7CDC
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=55AB9367-2A65-42E2-AFE4-D9B292FB7CDC
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=70E832C6-156D-4807-9200-E1E077768D5D
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=70E832C6-156D-4807-9200-E1E077768D5D
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=267CF459-0683-42FD-A561-663B3E989425
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=267CF459-0683-42FD-A561-663B3E989425
https://dsm.deltek.com/
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Document Name Description 

Deltek Costpoint 7.1.1 Content Management 
Integration 

This document describes how to configure and 
tune the Costpoint Content Management 
Integration (CMI) application to provide access 
to Microsoft SharePoint™, as well as other 
Content Management Systems (CMS) that are 
compliant with the Content Management 
Interoperability Standard (CMIS). 

Deltek Costpoint 7.1.1 DB Wizard Utility This document describes how administers can 
use the DB Wizard utility to apply hot fixes and 
database structure changes to Costpoint 
installations. 

Deltek Costpoint 7.1.1 Deployment Options 
Technical Overview 

This document provides a high level overview 
of various Costpoint configuration options, 
including server, database, and security 
options. 

Deltek Costpoint 7.1.1 Integration Overview This document provides a high level overview 
of how Costpoint reports, processes, and data 
can be integrated with third-party applications 
via Web services. 

Deltek Costpoint 7.1.1 Integration Console This document is a detailed guide to the 
Costpoint Integration Console, which 
automates the process of integrating Costpoint 
reports, processes, and data with third-party 
applications via Web services. 

Deltek Costpoint 7.1.1 Message Boards This document describes how integration 
between Costpoint and MS Exchange can 
enable collaboration among Costpoint users 
as well as between Costpoint and non-
Costpoint users. This capability also allows 
you to link e-mails with attachments directly to 
Costpoint documents and view them directly 
from Costpoint. 

Deltek Costpoint 7.1.1 Monitoring Utility This document describes how to use the 
Monitoring Utility to diagnose Costpoint 
configuration problems. 

Deltek Costpoint 7.1.1 Performance 
Optimization 

This document contains Costpoint 
performance tips and tricks, information on the 
configuration of the Deltek performance lab, as 
well as a list of optimized applications for the 
Oracle parallel SQL execution option. 

Deltek Costpoint 7.1.1 Post Installation 
Hardening Guide 

This document presents common principles 
and recommendations that administrators 
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Document Name Description 

should consider for post-installation hardening 
of the Costpoint server environment. 

Deltek Costpoint 7.1.1 Process Execution 
Modes 

This document describes the many options for 
executing reports and processes in Costpoint, 
including using interactive and batch modes 
and job servers. 

Deltek Costpoint 7.1.1 Security This document describes user authentication 
and other security safeguards in Costpoint. 

Deltek Costpoint 7.1.1 User Migration Utility This document describes how to migrate users 
from earlier Costpoint versions to Costpoint 
7.1.1. 

Deltek Costpoint 7.1.1 Extensibility Designer 
Coding Guide 

This document contains java coding 
information for Costpoint Extensibility 
developers. 

Deltek Costpoint 7.1.1 Extensibility Designer 
Quick Start Guide 

This document outlines the basic steps for 
creating and deploying extensibility. 

Deltek Costpoint 7.1.1 Extensibility Designer 
Report Guide 

This document describes how to extend a 
report. 

Deltek Costpoint 7.1.1 Extensibility Designer 
User Guide 

This document contains detailed instructions 
for using the Costpoint Extensibility Designer. 

Deltek Costpoint 7.1.1 Screen Customization 
and Business Logic Extensibility 

This document is an overview of Costpoint’s 
screen customization and business logic 
extensibility features. 

Deltek Costpoint 7.1.1 Continuous Delivery 
Model White Paper 

This document contains details on Deltek’s 
Costpoint Continuous Delivery Model. 
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Enhancements Related to the Initial Integration 
with Costpoint  
When Budgeting & Planning was initially converted to Costpoint, the version 6.1 Organization, Project, 
and Administration context areas were integrated within existing Costpoint domains. For example, the 
Organization applications existed within the Accounting domain, and the Project applications existed 
within the Costpoint Projects Domain.  

 

Consolidation of 6.1 Context Areas within Costpoint 
As part of the initial conversion to the Costpoint architecture and framework, the version 6.1 Cost 
Analysis, Budget Development, and Performance & Variance context areas consolidated. In version 6.1, 
the modules within these areas contained many of the same reports, but each report had to be run 
separately.  

In version 7.0, this has all been streamlined. There is now one report screen instead of three, and the 
screen includes a new radio button, where you can select the type of data you want to view.  For more 
information, see Combined Report Screens. 

Additionally, where there was an option to run a report for all periods, that option has also been 
consolidated, so it too may be run from the primary screen. 

 

Note: As of August 2018, all the Budgeting & Planning applications were consolidated into a separate 
“Planning” domain. That enhancement is described in detail under Planning Domain Created on page 
12 of this document.  

The Costpoint interface was recently updated and the screenshots included in this document may not 
reflect the current application. Please refer to the Costpoint Release Notes for more information 
regarding this enhancement. 

Note also that the GA release was also referred to as Cumulative Update 08. 

Note: Due to this change, the Cost Analysis, Budget Development, and Performance & Variance 
context areas are obsolete in version 7.0. Instead, reports are now grouped directly on the menus 
according to type (for example, Profit and Loss, Level Down, and Active Level). Refer to the Menu 
Mapping documents for exact menu comparisons. 
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Combined Report Screens 
Budgeting &Planning 7.0 now has combined report screens for enhanced user experience and ease of 
use. You now have the option to choose either a Cost, Budget, or Performance & Variance report and set 
it to combined or not. 

The screen image below demonstrates how to select the type of report you want to run, and how to 
display lower-level report details using the subtask structure. 

 

 

The following is a screen image of the Labor Cost Analysis report. 
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Project Budgeting  
This section describes changes made to Project Budgeting.  

To open the application, click Planning » Project Budgeting » Budget/EAC Processing » Project 
Budgets/EACs. 

 

Summary of Changes from 6.1 to 7.0: 

 Budgeting & Planning 7.0 now has Create Bud, Create EAC, Modify, Commit and Delete 
buttons. 

All Budget related functions are now completed from a single screen; all these were previously 
separate apps in 6.1: 

 B.P.I.1 - Create/Modify Budget for Direct Project 

 B.P.I.2 - Audit/Modify All Direct Project Budgets 

 B.P.I.4 - Create/Modify EAC for Direct Project 

 B.P.I.5 - Audit/Modify All EACs for Direct Budgets 

 Use the Project Budgeting screen to access the New Revenue setup in 7.0  

o To set up revenue, go to Projects » BNP Project Budgeting » Budgeting/EAC 
Processing » Project Budgets/EACs » click Revenue Setup/Ceilings subtask and 
select the Revenue Setup link. 
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Organization Budgeting 
This section describes changes made to Organization Budgeting.  

To display the screen, click Planning » Organization Budgeting » Budget/Outlook Processing » 
Organization Budgets/Outlooks. 

 

Summary of Changes from 6.1 to 7.0: 

 Budgeting&Planning 7.0 now has Create Bud, Create OLK, Modify, Commit and Delete 
buttons. 

 All Org Budget/Outlook functions can now be completed from a single screen in 7.0 ; all of these 
were previously separate apps in 6.1: 

 B.O.I.1 - Create/Modify Budget for an Organization 

 B.O.I.2 - Audit/Maintain Organization Budgets 

 B.O.I.3 – Create/Modify Outlook for an Organization 

 B.O.I.4 – Audit/Maintain Organization Outlooks 

 A.O.S.1 Review Status of Org Budgets 
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Major Enhancements: Planning Domain and New 
Business Budgeting Module 
This section contains descriptions of major enhancements that included structural changes, such as the 
creation of separate domain to house all applications related to Costpoint Planning and the redesign of 
the Proposal module to New Business Budgeting.   

Planning Domain Created 
Released August 2019 

A Planning Domain was added to Costpoint so that all the Budgeting & Planning applications can be 
housed in the same location. Previously, Budgeting & Planning applications were contained within three 
separate Costpoint domains (Accounting, Projects, and Administration).   

 

A Proposal Budgeting module was also added, which contains certain applications that were previously 
located within Project Budgeting. Additionally, planning-specific applications were relocated to a new 
Resource Planning module. 

 

The new domain and restructured menu help accommodate the many users who only need access to the 
planning capabilities of Budgeting & Planning.  

 

Note: This enhancement includes changes to security that will affect the ability of users to access 
certain applications. See “Security Changes Required for New Modules” below for related 
information. 

Note: Additionally, a quick reference to where specific applications are located within Costpoint 
Planning, refer to the following documents: 

 DeltekBudgetingandPlanning70MenuMapping70to61 

 DeltekBudgetingandPlanning70MenuMapping61to70 



Major Enhancements: Planning Domain and New Business Budgeting Module 

General Availability Release Notes 15 

 

 

Proposal Budgeting Module 
Proposal Budgeting is now a separate module.  

This module contains the Actions/Processing and the Reports/Inquiries applications. 

 
 

 
 

 

New Resource Planning Module 
A new module called Resource Planning was also created. This module contains the Budget By 
Resource application. This module contains the Budget By Resource application, which was initially 
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released in March 2018 under Projects. See “Resource Planning” for additional information about this 
application. 

 

Administration Module Changes 
Budgeting Administration module was changed to Administration and the File Management module was 
removed. File Management is now part of the Costpoint Administration Domain. 

   

Security Changes Required for New Modules 
The CP administrator needs to assign the Proposal Budgeting and Resource Planning modules to the 
User Groups affected otherwise they will have no access to the new modules until new security is added. 

To set User Groups, complete the following steps: 

1. Click Administration » Security » System Security » Manage User Groups. 

2. Select Assign Users to Group subtask 
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3. Select Module Rights subtask 

 

 Module Rights — Use this subtask to assign Read-Only, Full, or Deny rights in one or more 
Costpoint modules to a user group by company. 
 

For a complete listing of the new menu structure, see 
DeltekBudgetingandPlanning700MenuMapping70to61.pdf 

Requirements 

The enhancement requires   

cp711_bnp_common_011.zip 

Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module » 
Application 
Group 

Application ID Application 
Name 

Application File 

Planning Resource 
Planning  » 
Resource 
Planning 

BNP_BGMBPIR Budget by 
Resource 

cp711_bp_bnp_bgmbpir_006.
zip 

 

Planning  

Proposal 
Budgeting » 
Actions 
Processing  

BNP_NBMNPI4 Project 
Proposals 
(NPI4) 

cp711_bp_bnp_nbmnpi4_007
.zip 

 

http://ashapt535vs:82/SYMGRP_Module_Rights_Subtask.html
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New Business Budgeting Replaces Proposal Budgeting  
Released April 2019 

The Proposal Budgeting module was redesigned and replaced with a new module named New Business 
Budgeting.  

As part of the redesign, the applications that were used to create proposal and non-backlog budgets were 
merged into a single new application, which is opened by clicking Planning » New Business Budgeting 
» Actions/Processing » New Business Budgets.  

 

 

Because the New Business Budgets application incorporates the full range of functionality previously 
offered from several separate screens, the following applications no longer exist: 

 Create Proposal or Non Backlog (NPI1, NPI3, NPI6)  

 Project Proposals (NPI4) 

 Project Non-Backlog Budgets (NPI7) 

 Change Structured Proposal Start Date NPI10 

Updated Menu Structure and Labeling 
Instances of “Non-Backlog” and “Proposal,” either in the menu structure or in field labels, have been 
replaced with “New Business Budget.” For example, the Create Budget from Proposal (NPI8) application, 
which remains within the new module, was renamed to Create Project Budget from New Business Budget 
(NPI8). 

Where the Help topics may have previously made generic references to “proposals,” “proposal budgets,” 
or “non-backlog budgets,” all equivalent instances now and in future releases will be referred to as “new 
business budgets.”  
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The revised menu includes New Business Budgets and Create Project Budget from New Business 
Budget (NPI8): 

 

Overview: New Functionality and Other Changes 
The table below provides an overview of key improvements and other functionality changes. Where 
applicable, refer to other topics within this document for additional information or detailed instructions.  

Feature or Change Description 

Work Breakdown Structure 
Requirement 

Previously you could enter budget details only at the contract 
level. You can now enter the entire budget structure and choose 
the level at which you want to budget.  

See the “Create the Work Breakdown Structure for a New 
Business Budget” procedure later in this document.  

Create any budget type from 
scratch 

All budgets for new business can now be created from scratch. 
Previously, you could create proposals from scratch, but non-
backlog budgets could be created only from a proposal or 
another non-backlog project budget.  

When you create a budget, you will be able to choose from the 
following Work Type designations: 

 Add On –Previously applied to non-backlog budgets. 

 New Work – Previously applied to describe non-backlog 
budgets. 

 Proposal – Previously applied to describe proposal 
budgets. 

In future releases, other designations will be added as well as 
the ability to create user-defined labels. 

Regardless of which Work Type you select, you have the option 
to create a budget from scratch by selecting “Blank” from the 
Source Budget Type drop-down list.  

See the “Create a New Business Budget” procedure later in this 
document. 

Create, Modify, Commit, and 
Delete Functionality 

Previously, you created proposal and non-backlog budgets from 
the Create Proposal or Non Backlog (NPI1, NPI3, NPI6) screen, 
and then entered or modified the budget details from either: 
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Feature or Change Description 

 Project Proposals (NPI4) 

 Project Non-Backlog Budgets (NPI7)  

You can now perform all functions related to budgeting from the 
New Business Budgets screen.  

As part of this update, the Create, Modify, and Commit buttons 
were converted to check boxes.  

 

After you select the check box, click . You will no longer 
receive a message indicating that the requested change is being 
processed. This change is similar to standard functionality in 
other Costpoint screens.  

To delete, you will use the standard Delete button that displays 
on all Costpoint tables.  

 

Select the row you want to delete, click , and then click 

.  

Note: When deleting levels of the WBS or budgets, you must 
always delete the lowest level first, or if you are deleting multiple 
rows, the lowest level must be included.  

Conversion of earlier non-
backlog and proposal 
budgets  

 

Your existing non-backlog and proposal budgets were merged 
into New Business Budgets. They can be used as a source for 
any new business budget that you create.   

See “Using Migrated Backlog and Proposal Budgets” later in this 
document for more information. 

Consolidation of Budget 
Sheets 

To improve the budget entry process, multiple subtasks were 
consolidated within two new subtasks: Hours and Amounts. 

 

See “Budget Subtask Consolidation” later in this document for 
details. 

New Business Budgets added 
to Budget by Resource 

In Planning » Resource Planning » Budget by Resource the 
following changes were made to fields in the Add/Edit/Delete 
Assignments Subtask: 

Type – References to Proposal and Non-Backlog were updated 
to “NB”  

Source -  References to Proposal and Non-Backlog were 
updated to “NB (New Business)” 
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Create the Work Breakdown Structure for a New Business Budget  
Before you can create the budget and enter budget details, you must first create the work breakdown 
structure (WBS). You will create the WBS in the New Business Budgets Status table of the New Business 
Budgeting screen. 

Each level of the work breakdown structure (WBS) is represented by a separate segment of the New 
Business Budget ID, and each segment is separated by a period (.).  

The first segment (parent segment) must conform to the five character length established for all Costpoint 
projects. 2nd level segment and down do not need to conform to the Project Settings, but have to be the 
same length within the same New Business Budget (NBB). 

 

When creating the WBS, you will create a row for each segment of the ID. For example, if you plan to 
budget at the lowest level, and the project is configured for up to three levels, you will create a total of 
three rows in the table.  

To set up the work breakdown structure for the new business budget: 

1. Click Planning » New Business Budgeting » Actions/Processing » New Business Budgets. 

2. In the New Business Budget ID field, clear any previous value from the field and enter the ID for 
the parent segment.  

3. Click to clear any remaining values from a previously displayed budget and to ensure that the 
ID does not already exist. 

4. In New Business Budgets Status table, click  to create the first row.   

The ID you entered automatically displays in the New Business Budget ID field of the table. This 
is the top level of the work breakdown structure.  

5. In the newly created row, enter or select values in the following required fields: Start Date, End 
Date, Org ID, and Account Group. You can optionally enter values in Description, Probability, 
Escalation, and Note. 

Other fields in the row are inactive until the budget is created.   

6. Click . 

With the first level of the WBS established, you can add more levels or create the budget at this 
level.  

7. To add another level to the work breakdown structure, do one of the following: 

 Click  in the New Business Budgets Status table to add a new blank row. 

 Select the first row and click  to add a row that contains all the same information. 

8. In New Business Budget ID, enter the ID for this level (segment) of the WBS, or if you copied 
the previous row, modify the value.  

Each segment of the ID must conform to the established length for that level and must be 
separated from the previous level with a period (.), for example: 10001.1111.  

Note: Segment lengths are configured in Costpoint from Projects » Project Setup » Project Setup 

Controls » Configure Project Settings » Project Segment Lengths. 
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9. Enter or select values in the required fields or modify the existing values if you copied the 
previous row. 

10. Click  . 

11. Decide the following: 

 Budget at this level of the work breakdown structure. See “Create a New Business Budget” 
below for instructions.  

 Add more levels to the work breakdown structure. Repeat steps 7-8 for each level you want 
to add.   

 

Create a New Business Budget  
After the WBS is established, you are ready to create the budget.   

To create a new business budget: 

1. To display the New Business Budgets application, click Planning » New Business Budgeting » 
Actions/Processing » New Business Budgets. 

2. In the New Business Budget ID field, enter the parent budget ID or click  to select it, if the ID 
is not already displayed.   

3. Click  on the toolbar.  

The WBS of the budget displays in the New Business Budgets Status table. The Level column 
indicates the WBS hierarchy. For example, if you created a WBS with three levels, there will be a 
row for each level, numbered 1, 2, and 3. 

Important: You can only budget at one level of the WBS. 

4. In the New Business Budgets Status table, identify the row (WBS level) where you want to enter 
budget details and select the Create Budget check box in that row. 

5. In Description, if you did not enter a description when you created the WBS, enter a value that 
describes this level of the budget. This field is optional.  

6. Click Shared to share the budget. This is optional. 

7. In Work Type, select a work type for the budget. Choose from options such as Add On, New 
Work, or Proposal. This field is required. 

8. In Source Budget Type, select the source you want to use to create the new business budget. 
This field is required. Options include the following:  

 Blank - Select this option to create it from scratch. If you select this option, there are no 
other required fields to complete in the New Business Budget Status table, and you can 
begin entering budget details by selecting any of the subtasks.  

 Project Budget - Select this option to create it from a project budget.   

 Project EAC - Select this option to create it from a project EAC. 

 New Business - Select this option to create it from another new business budget.  

Note: If you need to delete a level from the work breakdown structure, you are required to delete the 
lowest level first. You can delete multiple levels at the same time, provided the lowest level is 
included.  



Major Enhancements: Planning Domain and New Business Budgeting Module 

General Availability Release Notes 23 

 

9. In Source Budget ID, select the ID number of the source budget. This is required field, unless 
you selected Blank as the Source Budget Type.  

After you select the ID, the following fields populate automatically based on the selected source: 

 Source Version Number  

 Source Work Type fields  

 Start Date 

 End Date 

 Periods 

 Weeks   

 Escalation 

 Org ID 

 Account Group 

10. Click . 

With all the required fields completed in the New Business Budgets Status table, you can now 
enter or modify budget details using any of the subtasks. See “Consolidation of Labor Subtasks” 
below for new changes to labor-related budgets sheets. 

Using Migrated Non-Backlog and Proposal Budgets  
Your previously existing non-backlog and proposal budgets were migrated to New Business Budgets. 
They are available for use as a source budget, when you create a new business budget.  

To use a migrated budget as the source for a new business budget: 

1. Click Planning » New Business Budgeting » Actions/Processing » New Business Budgets. 

2. Follow all the steps described for creating the WBS.  

See “Create the Work Breakdown Structure for a New Business Budget” earlier in this document 
for instructions. 

3. In the New Business Budgets Status table, identify the row (WBS level) where you want to enter 
budget details and select the Create Budget check box in that row. 

4. In Description, if you did not enter a description when you created the WBS, enter a value that 
describes this level of the budget. This field is optional.  

5. In Work Type, select a work type for the budget. Choose from options such as Add On, New 
Work, or Proposal. This field is required. 

6. Click Shared to share the budget. This is optional. 

When you select the source for this budget, the field will be updated based on the setting in the 
migrated proposal or non-backlog.  

7. In Source Budget Type, select New Business.  

8. In Source Budget ID, click to select the migrated non-backlog or proposal budget that you 
want to use as the source for the new business budget. 

9. Click . 
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Values in the table are updated based on the source you selected.  

With all the required fields completed in the New Business Budgets Status table, you can now 
enter or modify budget details using any of the subtasks. 

Budget Subtask Consolidation 
To simplify the budget data entry process, multiple budget subtasks were consolidated into two new 
subtasks: Hours and Amounts.  

 

The Hours and Amounts subtasks include a new column, where the former subtasks now display as list 
values. A second column, also new, displays related values. 

In the first column of either subtask, you select the general type of hours or amounts you want to budget, 
and then in the ID Type column, you select the specific type. For example: 

Hours Subtask Table  Amounts Subtask Table 

 

 

 

For your reference, the screen images above display all the ID Type values. However, after you select a 
value from Hours Type or Amounts Type, the ID Type list updates accordingly. For example, if you 
choose Materials from Amounts Type, the ID Type list only includes Key Entry and Vendor.  

Lookup values for all other columns in the table (for example, Name, Acct ID, Org ID) also filter based on 
the values you selected in the first two columns. 

 

For additional updates made to New Business Budgeting following the initial release, see Other New 
Business Budgeting Enhancements on page 26. 

Requirements 
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cp711_bnp_common_018.zip 

cp711_bp_patch1319_001.zip 

cp711_bp_patch1335_001.zip 

cp711_bp_patch1336_001.zip 

cp711_bp_patch1337_001.zip 

cp711_bp_patch1338_001.zip 
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Enhancements (August 2018 – Present) 
This section describes features applied since August 2018, after Budgeting & Planning was converted to 
the Planning domain. The organization of this section reflects the structure of the new domain. To learn 
more about the Planning domain release, see Planning Domain Created above. 

For features applied to Budgeting & Planning prior to August 2018, see Enhancements (Through July 
2018) later this document.  

New Business Budgeting 
For more information about the release of the New Business Budgeting module, see New Business 
Budgeting Replaces Proposal Budgeting on page 16 of this document. 

Import New Business Budgets from Excel Added to New Business 
Budgeting  
Released June 2019 

A new Planning » New Business Budgeting » Controls and Utilities » Import New Business 
Budgets from Excel application was added that enables you to import multiple new business budgets 
from Excel and then upload them to the New Business Budgets application. 

 

From Import New Business Budgets from Excel application, you can do the following: 

 Download the pre-formatted Excel template.  

 Upload data from Excel to Costpoint Planning. 

 Select error reporting and duplication parameters, and after the upload is finished, review the 
results in the Upload Report subtask prior to uploading the data to the New Business Budgets 
application. 

 Review errors using the Error Report subtask. 

 Commit multiple new business budgets simultaneously to Costpoint Planning. 

Note: There is a prerequisite for the New Business Budget work breakdown structure (WBS) to 
already exist before budget data can be uploaded. The user should create the WBS ahead using the 
New Business Budgeting application before importing the budgets from excel. The import process will 
not create the WBS. 

For more information, click Help from the New Business Budget screen in Costpoint Planning and 

see the Set Up the Work Breakdown Structure help topic. 
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For example, 

 

Note that this application is functionally similar to the existing Project Budgeting » Controls and 
Utilities » Import Budget/EACs from Excel utility, which was released in 2018. If you have used that 
screen to import Project budgets/EACs, you will find that the process for importing new business budgets 
is the same except for the following differences: 

 You need to create a work breakdown structures (WBS) for any budgets/EACs you plan to 
import. If you are not familiar with creating the WBS, see online Help for Planning » New 
Business Budgeting » Actions/Processing » New Business Budgets.  

 Field names reflect New Busiess Budgeting.  

 Column Name was changed to Budget ID. 

 When If a New Business Budget already exists, do you want validations to create an error 
when Uploading File? is selected as No, the options under If a New Business Budget already 
exists, do you want to are as follows: 

 Overwrite complete Budget —the budget for the entire period of performance, including 
past, current and future periods, will be overwritten by the .xml uploaded file. 

 Overwrite budgeted periods in Template only —the existing budgeted periods will be 
overwritten by the budgeted periods on the template. Periods without budgeted amounts on 
the template will not overwrite any existing budgets in those periods. 

 

Import New Business Budgets Configuration Update 
An Import New Business Budgets from Excel Commit Flag Default check box was added to 
Planning » Administration » Administration Controls » Configuration Settings (MAM10) » Project 
tab.  

Note: For additional information on using this application, click Help from Planning » New Business 

Budgeting » Controls and Utilities » Import New Business Budgets from Excel. 
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When you select this option, the Commit check box on the Upload Report subtask of the Import New 
Business Budgets from Excel application is selected by default, but the user can change the status.   

 

Report Consolidation  

Within New Business Budgeting » Reports/Inquiries, the Proposal Summary NPT1 report and Non-
Backlog Budget Revenue Summary NPT2 reports were consolidated into a new, single report called New 
Business Budget Summary (Revenue/Cost).  

 

Use this new report to select a top level New Business Budget ID and to view a summary of revenue, 
profit, and cost categories for the budget hierarchy. Click the All Cost Breakdown subtask to drill-down 
into the details of revenue, cost categories and burdens over the budget period of performance. 

For more information, click Help from the New Business Budget Summary (Revenue/Cost) screen in 
Costpoint Planning. 

Requirements 

cp711_bnp_common_020.zip 

The following table shows the required file for the screen affected by this update: 

Module » 
Application Group 

Application ID Application 
Name 

Required File 

Administration » 
Administration 
Controls 

BNP_BAMMAM10 Configuration 
Settings 
(MAM10) 

cp711_bp_bnp_bammam10_014.zip 

cp711_bp_patch1344_001.zip 

New Business 
Budgeting » Control 
and Utilities 

BNP_NBPNBUE Import New 
Business 
Budgets From 
Excel 

cp711_bp_bnp_nbpnbue_001.zip 
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Module » 
Application Group 

Application ID Application 
Name 

Required File 

New Business 
Budgeting » 
Reports/Inquiries  

BNP_NBQNBBS New Business 
Budget 
Summary 
(Revenue/Cost) 

cp711_bp_bnp_nbqnbbs_001.zip 

Other New Business Budgeting Enhancements 
Released July 2019 

This section describes additional enhancements applied to the New Business Budgeting module, 
including the following:   

 Employee Schedule Subtask 

 Multi-New Business Budget Consolidation (Rev/Cost) 

 Structured New Business Summary (Rev/Cost) 

Employee Schedule Subtask 

New Business Budgeting was updated to include the Employee Schedule subtask, which Project Budget 
Analysts can use to view all the projects to which an employee is currently budgeted, including total 
scheduled hours and total remaining hours.   

To display the employee schedule subtask, go to Planning » New Business Budgeting » 
Actions/Processing » New Business Budgets » Hours subtask 

Note that for subcontractor hours and consulting hours only total available hours by period are displayed 
without the deduction of scheduled hours.  

Multi-New Business Budget Consolidation (Rev/Cost) 

Multi-Proposal Consolidation (Rev/Cost) (NPT3) was renamed to Multi-New Business Budget 
Consolidation (Rev/Cost), and it was also updated with additional functionality. 

Use this application to specify individual new business budgets to be reported as part of a consolidation 
project revenue and/or cost report. The report runs a consolidated single report based on the new 
business budgets that you have selected. 

Grouping Description 

You can now name the group of New Business Budgets that you have selected and save it for future use. 

Enter the group description in the Grouping Description field and click Save Group to save the group 
description for future lookup to review the same grouping.   

When you return to this application, you can search the group name and select the group. To check, use 
the lookup in the Grouping Description field to find the Group and click Select Group to populate the 
result set.  The result set will display all New Business Budgets but those in the group will be highlighted 
by row.  Additional new business budgets can be selected and added to the Group when you click Save 
Group. 

Click Delete Group to remove the group from the Grouping Description selection. 
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All Cost Breakdown Subtask 

After you have selected your budgets, click the All Cost Breakdown subtask to review the summarized 
cost categories.  You can drill down to find the GL accounts and which New Business Budget the data is 
coming from. All periods in the budgeted start and end dates are also displayed. 

To access the Multi-New Business Budget Consolidation (Rev/Cost) application, go to Planning » New 
Business Budgeting » Reports/Inquiries » Multi-New Business Budget Consolidation (Rev/Cost). 

Structured New Business Summary (Rev/Cost) 

Structured Proposal Summary (Rev/Cost) NPT4 was renamed to Structured New Business Summary 
(Rev/Cost), and it was also updated with additional functionality. 

Use this application to run a report that displays cost or revenue amounts on individual New Business 
Budgets within a selected period of performance. All completed budgets regardless of work type whether 
Proposal, Work Type, or Add On are displayed. Hours and Amounts in the New Business Budgets display 
in the Structured New Business Budget Summary as amounts. 

All Cost Breakdown Subtask 

Use the All Cost Breakdown subtask to view summary rows by cost category, description, and total 
budget with the ability to drill down to the G/L Account and resource. 

To access the Structured New Business Summary (Rev/Cost) application, go to Planning » New 
Business Budgeting » Reports/Inquiries » Structured New Business Summary (Rev/Cost). 

Requirements: 

cp711_bnp_common_022.zip 

Project Budgeting 

Budget Labor Hours by GLC or PLC 
Released August 2018 

Labor budgeting was enhanced to allow budgeting by labor category, either GLC (General Labor 
Category) or PLC (Project Labor Category), without the need to specify a resource. 

This update was applied to the following applications within the Planning Domain: 

 Project Budgeting » Budget/EAC Processing » Project Budget/EACs  

 Proposal Budgeting » Actions/Processing » Project Proposals (NPI4)  

 Proposal Budgeting » Actions/Processing » Project Non-Backlog Budgets (NPI7)  
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When budgeting labor in the Staff Hours, Subcontractor Hours, or Consultant Hours subtasks in any of 
the above applications, you can assign hours directly to a labor category by selecting either GLC or PLC 
from the ID Type drop-down list.  

 

The PLC column within these subtasks was renamed to GLC/PLC. The codes available for selection are 
determined by the ID Type selected. After you select the code, you can modify the Hr Rate field as 
needed. The amount in the Hr Rate field is the cost associated with the GLC/PLC. 

 

Note that if the Hr Rate field defaults to zero and you do not enter a rate, revenue will not be offset by 
labor costs. 

Prior to this enhancement, the cost (Hr Rate) of the resource (for example, employee, subcontractor, or 
consultant) was already established, so revenue was automatically offset by cost within the budget. 

To help you manage GLC and PLC rates, two new applications have also been added to Budgeting & 
Planning.  

Manage Cost Rates 
Released August 2018 

To establish PLC and GLC rates outside of the budgeting application, use the following screens: 

 Planning » Project Budgeting » Controls and Utilities » Manage Average Cost GLC Rates  

 Planning » Project Budgeting » Controls and Utilities » Manage Average Cost PLC Rates 

Note that these are existing Costpoint screens (Projects » Advanced Project Budget Controls) which 
were added to the Budgeting & Planning menu structure, so though technically not new, they are new 
within Budgeting & Planning. 

These “new” screens are used to add or edit cost rates for an existing GLC or PLC. When that GLC or 
PLC is selected in a budgeting application, the rate automatically populates the HR Rate field. However, 
since that field remains editable, the rate can still be modified from within the budgeting application.  

To learn more about these screens, see the following in the online Help: 

 Manage Average Cost GLC Rates 

http://ashapt496vs/cpweb/helpfiles/costpoint/BPMAGLC.html
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 Manage Average Cost PLC Rates 

Project Labor Category Subtask Updates 
Released August 2018 

Other changes related to this feature were applied to the Project Labor Categories subtask, including the 
following: 

 To improve usability, the subtask link now displays directly on the Project Budgets/EACs screen. 
It was previously located on the Revenue Setup/Ceilings subtask.   

 Column labels were updated as follows: 

Link to Accounting System PLC label was changed to Link to Project PLC. 

Accounting PLC was changed to Project PLC. 

Accounting PLC Description was changed Project PLC Description. 

Labor Report Updates 
Released August 2018 

Project Budgeting reports are currently in the process of being updated to include labor hours budgeted 
by GLC or PLC. For this current release, the Revenue Analysis (BPA17) report was updated. Additional 
reports will be updated in future releases.  

Requirements 

cp711_bnp_common_011.zip 

Released October 2018 

Labor reporting within Budgeting & Planning is being updated to include hours that were budgeted by 
labor category (GLC or PLC) only, that is, without an identified resource, within any of the following 
applications. 

 Project Budgeting » Budget/EAC Processing » Project Budget/EACs  

 Proposal Budgeting » Actions/Processing » Project Proposals (NPI4)  

 Proposal Budgeting » Actions/Processing » Project Non-Backlog Budgets (NPI7)  

When budgeting labor in the Staff Hours, Subcontractor Hours, or Consultant Hours subtasks in any of 
the above applications, hours assigned according to GLC or PLC will be reflected in certain associated 
reports. 

For this release, the following reports were updated to include labor hours budgeted by GLC or PLC.   

 Multi-Proposal Consolidation (Rev/Cost) (NPT3) 

 Non-Backlog Budget Revenue Summary (Rev/Cost) (NPT2) 

 Proposal Summary (Rev/Cost) (NPT1) 

 Project Labor Analysis (SPA6) 

 Project Status (SPA5) 

 Project Budgets/EACs Status (APS1,APS3) 

 Level Down Projects Future Revenue (BPL3) 

 Revenue Breakdown (BPA15) 

http://ashapt496vs/cpweb/helpfiles/costpoint/BPMAPLC.html
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 T&M Budget Review (BPA13) 

For more information on how to budget labor by GLC or PLC, see 
“DeltekBudgetingandPlanning700ReleaseNotesBudgetLaborByGLC-PLC.pdf.” 

Project Budget Security Applied to Import of Budgets/EACs 
Released October 2018 

Back-end changes related to Project Budget Security have been applied to the following applications:  

 Import Budget/EAC from Scheduling App (BPU1, BPU3, BPU5, NPU1)  

 Import Budget/EACs from Excel 

These changes are automatically applied to these applications if Project Security to be based on is 
selected as Project Budget Security on the Project tab of Planning » Administration » Administration 
Controls » Configuration Settings (MAM10). 

When Project Budget Security is applied in these applications, uploaded projects are validated based on 
user rights. If the user does not have rights to a project, the project is not uploaded and the error is 
flagged. 

To learn more about Project Budget Security, see 
"DeltekBudgetingandPlanning700ReleaseNotesMaintainProjectBudgetSecurityApplication.pdf" 

Requirements 

The following table shows the required file for the screen affected by this update: 

Domain » Module » 
Application Group 

Application ID Application Name Required File 

Planning » Project 
Budgeting » Control and 
Utilities 

BNP_BGMBPUX Import Budget/EAC 
From Scheduling App 
(BPU1,BPU3,BPU5,
NPU1) 

cp711_bnp_common_013.
zip 

Planning » Project 
Budgeting » Control and 
Utilities 

BNP_BGPBPUE Import Budget/EACs 
from Excel 

cp711_bnp_common_013.
zip 
cp711_bp_bnp_bgpbpue_
005.zip 

Updates to Labor Hours Analysis (CPT5, BPT5, PPT5) and Labor Cost 
Analysis reports (CPT6, BPT6, PPT6) 
Released January 2019 

Project Budgeting reports were enhanced to include the ability to display All Periods in the Labor Hours 
Analysis (CPT5, BPT5, PPT5) and Labor Cost Analysis reports (CPT6, BPT6, PPT6) like in other reports.  
Previously, users could only view up to 7 periods. 

Date Range (From and To) was added to both Labor Hours Analysis (CPT5, BPT5, PPT5) and Labor 
Cost Analysis reports (CPT6, BPT6, PPT6) whether Cost, Budget/EAC or Variance. The date range 
entered drives the FY/Period columns displayed on the report. When the Details link is clicked, only 
hours for Projects budgeted during the Date Range are displayed. There are no changes to current 
behavior when the ‘Combined’ check box is selected, except that the FY/Period columns are now driven 
by the Date Range selected.  

https://dsm.deltek.com/DeltekSoftwareManagerAdministrator/
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=8FE6BE1C-525D-47F4-B8F9-6AF12255A8C6
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Total Hours column was added and column label was changed from Committed Hours to Pending 

Hours in Labor Hours Analysis (CPT5, BPT5, PPT5). Also, column label in Labor Cost Analysis (CPT6, 

BPT6, PPT6) was changed from Committed Cost to Pending Cost and Total Cost column was added. 

 

Requirements 

The following table shows the required file for the screen affected by this update: 

Domain » Module » 
Application Group 

Application ID Application Name Required File 

Planning » 
Administration » 
Administration Utilities 

BNP_CAQXPT5.htm Labor HoursAnalysis 
(CPT5, BPT5, PPT5) 

cp711_bp_bnp_caqxpt5_003.zip 

Planning » Project 
Budgeting  » Top Level 
(All Projects) Reports  

BNP_CAQXPT6.htm Labor Cost Analysis 
(CPT6, BPT6, PPT6) 

cp711_bp_bnp_caqxpt6_003.zip 

Import GLCs/PLCs from Excel 
Released February 2019 

The Planning » Project Budgeting » Controls and Utilities » Import Budget/EACs from Excel 
application was updated to include the ability to import GLC and PLC information.  

To support this change, the Excel template was updated as follows: 

 The ID Type field drop-down list was updated to include GLC and PLC. 

 The PLC column was renamed to GLC/PLC. 

 If ID Type is GLC or PLC, the GLC or PLC ID should be entered in GLC/PLC column.  

 The ID column is not required and must be blank. 
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To download the updated template, complete the following steps: 

1. Click Planning » Project Budgeting » Controls and Utilities » Import Budget/EACs from 
Excel to display the utility. 

2. Click the Excel Template subtask link. 

3. In the Excel Template subtask, copy the URL and paste it into a web browser. 

4. Save the template to your specified location. 

To add a code, select GLC or PLC from ID Type drop-down.  

Either selection requires an hourly cost rate. You can manually enter the rate in the Hourly Rate column 
of the spreadsheet, or leave it blank to use the default value from Planning » Controls and Utilities » 
Manage Average GLC Cost or Manage Average PLC Cost.  

Note, however, that if a default value does not already exist, the cost rate will be zero. 

Requirements 

The enhancement requires: 

cp711_bp_bnp_bgpbpue_008.zip 

Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module » 
Application Group 

Application ID Application 
Name 

Application File 

Planning Project Budgeting » 
Controls and Utilities  

bnp_bgpbpue.htm Import 
Budget/EACs 
from Excel 

cp711_bp_bnp_bgpbpue_008.zip 

 

Ability to Create Budget From EAC Added to Project Budgets/EACs 
Released May 2019 

You can now extend your Project Budget periods and create a new Budget version from your current 
EAC for the new periods. Wage escalation occurs from the current period only and the past periods 
remain as Actual. 
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To Create a Budget from EAC, complete the following steps: 

1. Go to Planning » Project Budgeting » Budget/EAC Processing » Project Budgets/EAC. 

2. Highlight a row with an approved EAC. You will notice that the Create Bud action button is now 
available.  

3. Click Create Bud to create a Working status Budget with a sequential version number from the 
last Approved Budget.  

 The new Working Budget displays actual costs up to the current period. It includes the source 
EAC forecast to the end date. This end date is editable and can be extended. 

 The actual costs in the new Budget includes actual labor rates, up to the last closed period.  
Escalation will applies to those rates in current and future periods. 

Update to Configuration Settings (MAM10) 

Currently, when an EAC is created it brings actual costs into the budget up to the last period. For this 
release, Configuration Settings (MAM10) was updated to include an option to Unlock EAC Last Closed 
Periods. Selecting this option enables you to edit the last closed period actuals.   

This flag also allow edits to the last EAC period in the source EAC version used to create the new Budget 
version. You can now update late last period entries and audit changes in the new Budget version. 

 

Rollup Applied to Project Budgets/EACs 
Released May 2019 

In the Project Budgets/EACs screen, amounts entered in Distributed Rev and Budget Rev at lower 
levels of the project are now summarized at the top level.   

During rollup, if EACs and budgets are both present, the EAC always takes precedence and is rolled up 
instead of the budget. This is true even if the budget is more recent than the EAC. After Costpoint 
Planning determines which one to use, the amount is rolled up regardless of whether the budget/EAC 
status is Incomplete, Complete, Approved, or Working. 

Requirements 

The following table shows the required file for the screen affected by this update: 

Module » Application 
Group 

Application ID Application 
Name 

Required File 

Project Budgeting » 
Budget/EAC Processing 

BNP_BGMBPIX Project 
Budgets/EACs 

cp711_bnp_common_020.zip 
cp711_bp_bnp_bgmbpix_016.zip 
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Resource Planning 
The Planning » Resource Planning » Budget Resource Planning application was enhanced to enable 
you to: 

 Reschedule the start date and end dates of an assignment for a selected resource.  

 Reassign budgeted hours from one resource to another resource for an entire period or specific 
date range. 

This functionality was implemented through the addition of a new Assignment Actions dialog box, which is 
accessible after you: 

1. Open the resource record in the Budget Resource Planning application. 

2. Select the record in the Selected Resources table, select the resource. 

3. Click Add/Edit/Delete Assignments. 

4. Select the row that contains the hours you want to reschedule or reassign. 

5. Click Action in the Reassign Reschedule column. 

In the Assignment Actions dialog box, use the Reschedule tab to change the assignment dates for the 
selected resource, and use the Reassign tab to assign the hours to a different resource.  

In the Reschedule tab, you can only enter the new dates in the Reschedule Start Date. The Reschedule 
End Date is calculated using the same period of time in the original assignment dates. If you move the 
reschedule start date a year forward, the reschedule end date will also move a year forward.  

After entering the new dates, click Reschedule to change the assignment dates. 

 

 

 

 

 

For more information, see Resource Planning enhancement on page 71. 

 

Enter the 
new dates. 

End Dates are computed 
by the system. If the end 
date is outside the period 
of performance, a warning 
message displays. 

Click Reschedule 

If Commit is selected 
then the budgets will 
also be committed, 
otherwise a ‘Working’ 
version will be created. 
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Click the Reassign tab to assign the budgeted hours to a different resource. You can only select the same 
Resource Type as the current selection. If the current assignment is to an Employee, then only 
Employees can be selected in the Resource Type. 

 

 

 

To view the existing assignment of the selected resource, click the Current Assignments subtask. 

 

For more information on the Reschedule/Reassign functionality, see online help for Planning » 
Resource Planning » Budget Resource Planning. 

Requirements: 

cp711_bnp_common_022.zip 

Administration 

Project Budget Security Applied to Project Budgets/EACs 
Released August 2018 

The Project Budgets/EACs screen was updated to reflect changes related to the new Project Security to 
be based on setting in Planning » Administration » Administration Controls » Configuration 
Settings (MAM10).  

If Project Security to be based on is selected as Project Budget Security, users will now have 
restricted access to the projects that display in Project Budgets/EACs application. 

From the 
Reassign Period 
drop-down list, 
select the 
assignment 
period. 

Set the start 
and end dates 
if you selected 
Date Range 
under 
Reassign 
Period. 

Reassign the 
workload by 
percentage or 
by specific 
number of 
hours. 

Select the resource to which 
you want to reassign the 
hours. 

Click Reassign. 

If Commit is selected 
then the budgets will 
also be committed, 
otherwise a ‘Working’ 
version will be created. 



Enhancements (August 2018 – Present) 

General Availability Release Notes 39 

 

To learn more about this new security setting, see 
“DeltekBudgetingandPlanning700ReleaseNotesProjectBudgetSecurityOptionConfigurationSettings.pdf” 
from the July 2018 release. 

Requirements 

The following table shows the required file for the screen affected by this update: 

Domain Module » Application 
Group 

Application ID Application 
Name 

Required File 

Planning Project Budgeting » 
Budget/EAC Processing 

BNP_BGMPBIX Project 
Budgets/EACs 

cp711_bnp_common_01
1.zip 

Project Budget Security Enhanced 
Released August 2018 

A new Maintain Project Budget Security application was added that will enable Project Budget 
Accountants to separate Project Budget Creators and Project Budget Approvers similar to Org Budgeting. 

To access this new application, go to Planning » Administration » Administration Controls » Maintain 
Project Budget Security 

 

For more information screen fields, see the Maintain Project Budget Security online help topic. 

Configure Project Budget Security 

To use the Maintain Project Budget Security application, you need to select Project Budget Security 
from the drop-down menu of the Project Security to be based on field of the Project tab of Planning » 
Administration » Administration Controls » Configuration Settings (MAM10).   

Note that this configuration setting was added in July 2018, and the default setting is Org ID. 

Switching this setting to Project Budget Security allows Project Managers to approve and create project 
budget. If security is based on Org ID, and for example, a Project manager has a Home Org of an 
Overhead type, he or she could not edit project budgets and associated resources that have a Direct type 
of Home Org, such as Engineering or Construction. 

Note that with the addition of the new Project Security to be based on configuration option, the Manage 
Additional Project Budget Approvers (MAP8) screen was made obsolete and has been removed. 

https://dsm.deltek.com/DeltekSoftwareManagerAdministrator/
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During installation, existing entries from Project Budget Approvers (MAP8) are migrated to Maintain 
Project Budget Security, where they are denoted by “MAP8” in the Source field. 

 

Requirements 

The enhancement requires  
cp711_bp_patch1304_001.zip 

cp711_bnp_common_011.zip 

Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module » Application 
Group 

Application ID Applicatio
n Name 

Application File 

Planning Administration » 
Administration Controls 

BNP_BAMPBA Maintain 
Project 
Budget 
Security 

cp711_bp_bnp_bampba_001.
zip 

Vendor Employee Enhancements 
Released August 2018 

The Vendor Employee feature was further updated to include new configuration options as well as the 
ability to import budgets/EACs for Vendor Employees from Excel. 

Configuration Setting Updates 

The Planning » Administration » Administration Controls » Configuration Settings (MAM10) screen 
was updated as follows 

Workforce Rule Enforced for Vendor Employees  

If Workforce Rule on the Project tab is set to Enforce, that setting will now also be applied to Vendor 
Employees. Prior to this enhancement it only enforced Employee Workforce. Note that the following 
screen text was added next to this field: “Includes Employees, Vendors and Vendor Employees.”  

Note: This release includes menu changes related to the creation of the Planning Domain. It is highly 
recommended that cp711_sys_044.zip and cp711_bnp_common_011.zip be installed to reflect all 
framework changes, icons, positioning and application updates.  

Refer to DeltekBudgetingandPlanning700ReleaseNotesNewPlanningDomain.pdf in DSM for more 
details. 
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New Display Option  

An Include Vendor Employees in Vendor Lookups and Drop-Down lists check box was added to the 
Display tab. Select this check box to include Vendor Employees in drop-down lists for screen entry and 
reporting. 

 

Note that there is an existing setting for Employee Vendors (Include Employees Vendors in Vendor 
Lookups and Drop-Down ), which you should take care not to confuse with the new setting for Vendor 
Employees, who are employees of a subcontractor Vendor.  

Conversely, Employee vendors are regular employees who have been set up as Vendors in Accounting 
» Accounts Payable » Vendors » Manage Vendors so that they can submit Expense Reports that are 
processed through Accounts Payable. 

Import Vendor Employee Budget/EACs from Excel 
Released August 2018 

The Import Budget/EACs from Excel application was updated to include the ability to import budgets for 
Vendor Employees. 

To access this new option, go to Planning » Project Budgeting » Controls and Utilities » Import 
Budget/EACs from Excel, and click the Excel Template subtask.  
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Follow screen instructions for downloading the updated template, which now includes Vendor Employee 
as an option in the ID Type drop-down list. 

 

Note: An Hourly Rate for Vendor Employees should be completed on the Excel Template. 

Requirements 

The enhancement requires   

cp711_bnp_common_011.zip 

Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module » 
Application 
Group 

Application ID Application 
Name 

Application File 

Planning Administration bnp_bammam10 Configuration 
Settings 
(MAM10) 

cp711_bp_bnp_bammam10_010.zip 

 

New Period Rate Option for Calculation of Effective Rates 
Released October 2018 

The calculation of effective rates for salaried employees in Project budgeting was enhanced to derive a 
rate based on work hours per period versus work hours per annum, which was previously the default 
calculation.  

The addition of a period rate calculation allows for a more precise calculation of labor costs and revenue. 

How Effective Rates Are Calculated 

Prior to this enhancement, when effective rates were in use, the rate was based only on annual work 
hours, not hours per period. The annual rate was calculated by dividing the annual salary by annual work 
hours. For example,  

104,000 (annual salary) / 2080 (annual work hours) = 50.00 (effective rate)  

Annual work hours are derived from Work Hours in a Year on the Salary Info subtask in People » Labor 
» Employee Basic Information Salary Info Subtask. If that field is empty, it defaults to hours set up in 
Fiscal Year Setup (MAM16), and if that is empty, it defaults to 2,080 hours. 
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By contrast, the period rate calculation is not based on annual work hours, but is instead based on the 
available hours per period.   

The period for Project budgets (Project Budget Period field in Configuration Settings (MAM10)) can be 
based on either Costpoint accounting periods (and subperiods if used) or time collection periods, whereas 
Org budget periods are always based on Costpoint accounting periods, either accounting periods and 
subperiods or the accounting period only.  

For example, if the period includes 21 work days and the hours per day are 8, the hours available per 
period would be 168 (21 × 8). Extending this example to an employee who has an annual salary of 
104,000, the period effective rate would be calculated as follows:   

104,000 / 12 (fiscal periods) = 8,666.66 / 168 (hours available per period) = 51.59 (period effective 
rate) 

The annual rate example above yielded an hourly rate of 50.00, so the variance between the two rates is 
1.59. Therefore, especially when the budget runs less than a full year, the period effective rate produces 
a more accurate total for labor costs.   

Furthermore, if revenue is calculated using the hours worked multiplied by Project Labor Category rate, 
the variance will exist there as well. 

Configuring Rate Calculations 

Prior to this update, effective rates were enabled by selecting Use Effective Rates on the Org tab in 
Configuration Settings (MAM10). Because the effective rate was calculated only one way, the option was 
controlled by a check box, which was either checked or unchecked, indicating whether effective rates 
were in use or not in use.  

After the update is installed, your current status is maintained. If effective rates were in use prior to the 
update, it will default to the annual rate calculation. If effective rates were not in use, the feature is not 
enabled. 

To account for the new calculation option and its effect on Project Budgeting, the following changes were 
made: 

 The field label for the option was changed to Effective Rates to Use. The control was changed 
from a check box to a drop-down list with the following options: 

 None – Select this option if you do not want to use effective rates. This will be the default if 
effective rates are not already in use at the time of installation. 

 Annual Rates – Select this option to calculate the effective rate based on annual hours. This 
will be the default if effective rates are already in use at the time of installation. 

 Period Rates – Select this new option to calculate effective rates based on hours per period. 

 The option was moved from the Org tab to the General tab, because it will affect both Org 
Budgeting and Project Budgeting, including all of the following Project Budgeting applications: 
Project Budgeting » Budget/EAC Processing » Project Budget/EACs  

 Proposal Budgeting » Actions/Processing » Project Proposals (NPI4)  

 Proposal Budgeting » Actions/Processing » Project Non-Backlog Budgets (NPI7) 

 Additionally, the Refresh Process was also updated to capture changes related to this 
enhancement.  

Coming Soon… 

The period rate calculation will be applied to Organization Budgets – Outlooks in November 2018, and as 
part of that same update, Organization Budget Cycle Initialization (AOM3) will be updated to include a 
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new Standard Annual Hours column in the Employee Rates subtask. This will be used in conjunction with 
the Period Rate setting to calculate effective rates.  

Requirements 

The following table shows the required file for the screen affected by this update: 

Domain » Module » 
Application Group 

Application ID Application Name Required File 

Planning » 
Administration » 
Administration 
Utilities 

BNP_BAPREF
RESH 

Refresh Process cp711_bp_bnp_baprefresh_0
11.zip 

Planning » 
Budget/EAC 
Processing » Project 
Budgeting 

BNP_BGMBPI
X 

Projects Budgets/EACs cp711_bnp_common_013.zip 

Planning » 
Administration » 
Administration 
Controls 

BNP_BAMMA
M10 

Configuration Settings 
(MAM10) 

cp711_bnp_common_013.zip 

Display Variances in Favor of Budget or Actuals 
Released December 2018 

Budgeting & Planning was enhanced to allow the option of displaying variances in favor of either budget 
or actuals.  

Prior to this enhancement, variances always displayed in favor of actuals, and Budgeting & Planning 
calculated the variance for cost, revenue, and profit by subtracting budget from actuals, so if each was 
less than the budgeted amount, all three displayed a negative variance. 

As part of this enhancement, the calculation method was also updated so that whether favoring budget or 
actuals, the variance calculation for revenue and profit is the opposite of the cost calculation, which is 
explained in the section below.  

Because the variance calculation for revenue and profit is now always opposite to the cost calculation, 
and you can also control whether variances display in favor of either budgets or actuals, Budgeting & 
Planning now affords you greater flexibility in variance reporting. 

Configure Variance Reporting 

To support the new functionality, a Report Variance Calculation in Favor of setting was added to the 
Display tab of Planning » Administration » Administration Controls » Configuration Settings 
(MAM10). Options include:  

 Actuals – This is the default option. If you wish to display variances in favor of actual costs, no 
action is required. When this option is selected and actual costs are higher than budgeted costs, 
the variance displays as a negative. 

For example, $1,000.00 (actual material costs) - $800.00 (budgeted materials cost) = ($200.00).  
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 Budget – Select this option if you wish to display variances in favor of budgeted costs. When this 
option is selected and actual costs are higher than budgeted costs, the variance displays as a 
positive.  

For example, $1,000.00 (actual material costs) - $800.00 (budgeted materials cost) = $200.00. 

Revenue and Profit Variances 
For either configuration option (Actuals or Budget), the variance calculation for revenue and profit is now 
opposite to the cost calculation.  

For example, if actuals are favored and total revenue is 300,000 and budgeted revenue was 200,000, the 
100,000 variance will display as a positive. If budget is favored, it will display a negative.  

Reports Affected by the Variance Calculation 

The following is a list of Project Budgeting reports that have been updated for this enhancement, when 
Variance is selected as the Report Type. For a few reports, only certain columns display variances, which 
is also noted below.  

Top Level Reports  

 Direct Project Cost Categories (CPT1, BPT1, PPT1)  

 Direct Project Cost (CPT3, BPT3, PPT3)  

 Labor Hours Analysis (CPT5, BPT5, PPT5)  

 Labor Cost Analysis (CPT6, BPT6, PPT6)  

 Budget/EAC Status (APT1). For this report, only the Unplanned and Planned columns employ 
variance calculations.  

Level Down Reports 

 Project Cost Categories (CPL1, BPL1, PPL1) Project Cost (CPL2, BPL2, PPL2)  

Active Level Reports 

 Hours Breakdown (CPA1, BPA1, PPA1)  

 Raw Cost Breakdown (CPA2, BPA2, PPA2)  

 Burdened Cost Breakdown (CPA3, BPA3, PPA3)  

 All Cost Breakdown (CPA4, BPA4, PPA4)  

 Project Cost Chart (CPA8, BPA8, PPA8)  

 T&M Labor Analysis (CPA10, BPA10, PPA10)  

 Current Forecast (BPA16). For this report, only the Forecast Variance column is affected.  

Supplemental Reports 

 Project Budgets/EACs Status (APS1, APS3). For this report, only the Unplanned and Planned 
columns are affected.  

 Project Status (SPA5). For this report, only the Variance column is affected. 

Requirements 

cp711_bnp_common_015.zip 
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Application Jar Requirements 

The following table shows the required file for the screen affected by this update: 

Module » Application 
Group 

Application ID Application Name Required File 

Administration » Admin 
Controls  

BNP_BAMMAM10 Configuration 
Settings (MAM10) 

cp711_bp_bnp_bammam10_012.z
ip 

Project Budgeting » 
Reports/Inquiries » Top 
Level Reports 

BNP_CAQXPT1 Direct Project Cost 
Categories (CPT1, 
BPT1, PPT1)  

cp711_bp_bnp_caqxpt1_003.zip 

BNP_CAQXPT3 Direct Project Cost 
(CPT3, BPT3, 
PPT3) 

cp711_bp_bnp_caqxpt3_002.zip 

BNP_CAQXPT5 Labor Hours 
Analysis (CPT5, 
BPT5, PPT5) 

cp711_bp_bnp_caqxpt5_001.zip 

BNP_CAQXPT6 Labor Cost Analysis 
(CPT6, BPT6, PPT6 

cp711_bp_bnp_caqxpt6_001.zip 

BNP_OAQAPT1 Budget/EAC Status 
(APT1) 

cp711_bp_bnp_oaqapt1_002.zip 

Project Budgeting » 
Reports/Inquiries » 
Level Down Reports 

BNP_CAQXPL1 Project Cost 
Categories (CPL1, 
BPL1, PPL1) 

cp711_bp_bnp_caqxpt1_003.zip 

BNP_CAQXPL2 Project Cost (CPL2, 
BPL2, PPL2) 

cp711_bp_bnp_caqxpt3_002.zip 

Project Budgeting » 
Reports/Inquiries » 
Active Level Reports 

BNP_CAQXPA1 Hours Breakdown 
(CPA1, BPA1, 
PPA1) 

cp711_bp_bnp_caqxpa1_002.zip 

BNP_CAQXPA2 Raw Cost 
Breakdown (CPA2, 
BPA2, PPA2) 

cp711_bp_bnp_caqxpa2_002.zip 

BNP_CAQXPA3 Burdened Cost 
Breakdown (CPA3, 
BPA3, PPA3) 

cp711_bp_bnp_caqxpt1_003.zip 

BNP_CAQXPA4 All Cost Breakdown 
(CPA4, BPA4, 
PPA4) 

cp711_bp_bnp_caqxpa4_002.zip 
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Module » Application 
Group 

Application ID Application Name Required File 

BNP_CAQXPA8 Project Cost Chart 
(CPA8, BPA8, 
PPA8) 

cp711_bp_bnp_caqxpa8_004.zip 

BNP_BGQBPA10 T&M Labor Analysis 
(CPA10, BPA10, 
PPA10) 

cp711_bp_bnp_caqxpa10_004.zip 

BNP_BGQBPA16 Current Forecast 
(BPA16) 

cp711_bp_bnp_bgqbpa16_004.zip 

Project Budgeting » 
Reports/Inquiries » 
Supplemental Reports 

BNP_OAQAPSX Project 
Budgets/EACs 
Status (APS1, 
APS3) 

cp711_bp_bnp_oaqapsx_003.zip 

BNP_SRQSPA5 Project Status 
(SPA5) 

cp711_bp_srqspa5_006.zip 

Update to Configurations Settings (MAM10)  
Released April 2019 

The Configuration Settings (MAM10) was enhanced and the configuration setting "Allow EAC creation 

prior to period close" is now included.  

Users can now select from the following options: 

 Create EACs based on Last Closed Period (Standard Function) 

 Create EACs based on Current Period  

To select these options, go to Planning » Administration » Administration Controls » Configuration 

Settings (MAM10) » Project Tab 
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Currently, the system defaults to Create EACs based on Last Closed Period (Standard Function). 

This means that when you create an EAC, the date will be based on the maximum End Date from 

Maintain Fiscal Periods (MAM8, MAM9) and less than the current FY/PD (Maintain Current Period). 

 

When you select Create EACs based on Current Period, the end date that will be used when you 

create an EAC is the current period as specified as the End Date in Maintain Current Period application. 

 

 

For Example: 

1. Go to Configuration Settings (MAM10) » Project Tab. 

2. In the Allow EAC creation prior to period close drop-down menu, select Create EACs based 

on Current Period. 

3. Click . 

4.  Go to Project Budgets/EACs » click Create EAC. 

 

The Closed Period date displayed will be the End Date in Maintain Current Period application. 
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You do not need to Refresh the application for the changes in configuration to take effect. 

Also, when the Create EACs based on Current Period is selected the EAC created from an Approved 

Budget will bring in Actual transactions in the Current Planning Period and replace the Current Period 

Budget.   

If there are no Actual transactions, the Budget numbers will be removed in the Current Period. 

 

Requirements 

cp711_bnp_common_019.zip 
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Enhancements (Through July 2018)  
This section describes enhancements made to Budgeting & Planning from the initial version 7.0 release 
through July 2018, the last update preceding the release of the Planning domain in August 2018.  

Descriptions in this section reflect the module, application, and menu names as they existed prior to the 
Planning Domain release.   

Budgeting Administration 

Project Security Options Expanded 
Released July 2018 

A Project Security to be Based On option was added to the Project tab of the Configuration Settings 
(MAM10) screen. Options include Org ID or Project Budget Security. 

 

Prior to this enhancement, project security was automatically based on Org ID, which is still the default 
setting.  

This configuration setting was primarily added to support the forthcoming Maintain Project Budget 
Security screen that is scheduled for release in August 2018. The new screen will enable Project Budget 
Accountants to separate Project Budget Creators and Project Budget Approvers similar to Org Budgeting.  

Switching this setting to Project Budget Security allows Project Managers to view and edit all assigned 
budgets. If security is based on Org ID, and for example, a Project manager has a Home Org of an 
Overhead type, he or she could not edit project budgets and associated resources that have a Direct type 
of Home Org, such as Engineering or Construction. 

Requirements 

The enhancement requires:  

cp711_bp_bnp_bammam10_009.zip  
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cp711_bnp_common_007.zip 

Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module » Application 
Group 

Application ID Application 
Name 

Application File 

Admin Budgeting 
Administration » 
Administration 
Controls 

BNP_BAMPBA Maintain 
Project 
Budget 
Security 

cp711_bp_bnp_bammam10_009.

zip 

EACCT Table Updated with Account Name Details During Refresh 
Released June 2018 

During the refresh process, the EACCT table is now updated with Account Name details, enabling use of 
this information in Costpoint Enterprise Reporting.  

Requirements 

The enhancement requires cp711_bp_bnp_baprefresh_007.zip  

Dependent File 

cp711_bnp_common_005.zip;cp711_bp_patch1280_001.zip 

Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module » Application 
Group 

Application ID Applicatio
n Name 

Application File 

Admin Budgeting 
Administration » 
Administration Utilities 

BNP_BAPREFRES
H 

Refresh 
Process 

cp711_bp_bnp_baprefresh_007
.zip 

Changes to Configuration Files 
Released May 2018 

As Budgeting & Planning 7.0 is now integrated into the Costpoint database, many of the Configuration 
Settings are duplicates of settings already in Costpoint.   

In this release, files associated with configuration changes were modified to avoid redundancy and 
unused codes were removed due to obsolete values. 

Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module Application ID Application Name Application File 

Admin Budgeting 
Administration 

BNP_BAMMAM10 Configuration Settings 
(MAM10) 

cp711_bnp_common_008.zip 
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Domain Module Application ID Application Name Application File 

Admin Budgeting 
Administration 

BNP_BAMMAP1 Manage Project Direct 
Cost Type Table (MAP1) 

cp711_bp_bnp_bammap1_001.zip 

Admin Budgeting 
Administration 

BNP_BAPREFRES
H 

Refresh Process cp711_bp_bnp_baprefresh_006.zip 

Dependent File: 

cp711_bnp_common_005.zip;cp711
_bp_patch1280_001.zip 

Accounting Organizational 
Budgeting 

BNP_BGMAOM3 Organization Budget 
Cycle Initialization 
(AOM3) 

cp711_bp_bnp_bgmaom3_003.zip 

Accounting Organizational 
Budgeting 

BNP_OAQXOPX Plug Project Review 
(NOP1,NOI1,AOP1,AOP
2,AOP3) 

cp711_bp_bnp_oaqxopx_001.zip 

Projects Project 
Budgeting 

BNP_SRQSPA5 Project Status (SPA5) cp711_bp_srqspa5_002.zip 

Accounting Organizational 
Budgeting 

BNP_OAPAOI1 Compute Forward Rates 
(AOI1) 

cp711_bp_bnp_oapaoi1_002.zip 

Projects Project 
Budgeting 

BNP_BGMBPUX Import Budget - EAC 
From Scheduling App 
(BPU1,BPU3,BPU5,NPU
1) 

cp711_bp_bnp_bgmbpux_003.zip 

Changes to Project Tab  
Released May 2018 

The Project Budget Account Type field and drop-down menu was removed from the Project tab of 
Configuration Settings (MAM10) because in Budgeting & Planning 7.0, the Project Account Group (PAG) 
from the Costpoint project setup will be used by budgeting. 

 

EREPORT_PROJ_TREND Updated with Budget Details During Refresh 
Released January 2018 
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During the refresh process, the EREPORT_PROJ_TREND table is now updated with ITD and YTD 
budget details, enabling use of this information in Costpoint Enterprise Reporting.  

Requirements 

The enhancement requires cp711_bp_common_xxx.zip. 

Oracle Support 
Released March 2017 

Budgeting and Planning 7.0 now supports Oracle RDBMS. Customers will now have the option to switch 
from their existing Budgeting and Planning SQL Server database to Oracle. 

For more information, refer to Deltek Budgeting And Planning 700 Microsoft SQL Server to Oracle 
Migration document available through download in DSM. 

New Refresh Process 
Released March 2017 

The Budget & Planning refresh process was changed from a SQL CLR based application to a Costpoint 
Processing application compatible with both SQL & Oracle. 

Major Changes include: 

 B&P no longer maintains Costpoint and Time & Expense database connection information. This 
was removed from Configuration Settings (MAM10) and Post Install Setup. 

 Manually Start Data Refresh Process (MAM4) was changed to Refresh Process 
(BNP_BAPREFRESH). 

 For Costpoint 7.1.1 users, data is now pulled using the connection information already configured 
in Weblogic. No additional setup required. 

 For Costpoint 7.0.1 users, additional Custom Databases for Extensibility needs to be configured 
in Weblogic on the Costpoint 7.1.1 system hosting B&P. These include “Configure External 
Costpoint” and “Configure External Time & Expense” options under the B&P System tab. 

 

Step 1 - Create Refresh Job Parameters 

1. Open the Refresh Process application.  

To do this, go to Administration » Budgeting Administration » Administration Utilities » 
Refresh Process. 

2. Set Parameter ID to REFRESH. 

3. Set Description to B&P Refresh Process. 

4. Click Save & Continue. 

5. Exit the Refresh Process application. 

Step 2 - Create Job 

1. Open the Manage Jobs application.  

Note: As previously stated, do not perform this step until Operations has devised a common CP 
Transaction Database to pull data from. 
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To do this, go to Administration » Job Management » Job Management Codes » Manage 
Jobs. 

2. Set Job ID to BNPREFRESH. 

3. Set Description to B&P REFRESH PROCESS. 

4. On Application Failure group box, select Use Default. 

5. Set Default Priority to 1. 

6. On Job Operations grid, click New. 

7. Set Sequence to 1. 

8. Set Module to BA. 

9. Set Application to BNP_BAPREFRESH. 

10. Set Parameter to REFRESH. 

11. Set Process to BNP_BAPREFRESH_IMPORT. 

12. Click Save & Continue. 

13. Exit the Manage Jobs application. 

Step 3 - Create Job Queue 

1. Open the Manage Job Queues application.  

To do this, go to Administration » Job Management » Job Management Codes » Manage 
Job Queues. 

2. On the Job Queues form, click New. 

3. Set Job Queue ID to BNP. 

4. Click Save & Continue. 

5. Exit the Manage Job Queues application. 

Step 4 - Create Job Server 

1. Open the Start/Stop Job Server application.  

To do this, go to Administration » Job Management » Job Management  

Processing » Start/Stop Job Server. 

2. On the Job Servers form, click New. 

3. Set Server Name to BNPSERVER. 

4. In Destination Server select Default Server or Cluster. 

5. Click Save & Continue. 

6. Exit the Start/Stop Job Server application. 

Step 5 - Add Job to Queue 

1. Open Submit Job to Queue application. 

To do this, go to Administration » Job Management » Job Management Processing » 
Submit Job to Queue. 



Enhancements (Through July 2018) 

General Availability Release Notes 55 

 

2. Do a Query All. 

3. Set Locate Job to BNPREFRESH. 

4. Set Queue to BNP. 

5. Set Execution Option to Start Time/Date. 

6. Set Start Date to Tomorrow’s Date. 

7. Set Start Time to 0200. 

8. Set Recurrence Frequency to 11. 

9. Set Recurrence Timeframe to Days. 

10. Click Submit To Queue. 

11. Exit the Submit Job to Queue application. 

Step 6 - Assign Queue to Job Server 

1. Open the Start/Stop Job Server application.  

To do this, go to Administration » Job Management » Job Management Processing » 
Start/Stop Job Server. 

2. Select BNPSERVER Server 

3. On the Assigned Job Queues grid, click New. 

4. Set Job Queue to BNP. 

5. Set Active for Server to CHECKED. 

6. Click Save & Continue. 

7. Click Start. 

8. Exit the Start/Stop Job Server application. 

Changed Module Names  
Released September 2016 

The term “BNP” was removed from the module names and the following items are now reflected on the 
menu: 

 Organizational Budgeting 

 Project Budgeting 

 Budgeting Administration 

Ability to Select B&P Source Application in Post-Install Process  
Released May 2016 

The B&P Source Application(s) screen has been added in the Post-Install Process for this version 
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Organization Budgeting  

Employee Rates Inquiry 
Released April 2018 

A read-only screen is now available so users can view inquiry of the employee rates from AOM3, subject 
to org security. This enables certain users to view the employee rates of the employees that have been 
assigned to them. 

Users can only view Orgs and Employees within those Orgs that they have security to access.   

Labor suppression is applied to Hourly Rate. 

To view Employee Rates Inquiry, go to Accounting » Organizational Budgeting » Labor Analysis 
Report » Employee Rates Inquiry. 

Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module Application ID Application Name Application File 

Accounting Organizational 
Budgeting 

BNP_BGQEOR Employee Rates Inquiry cp711_bnp_common_007.zip 

 

Mass Upload Project Budgets to Organization Budgets  
Released August 2017 

You can now mass update Org Budgets with Proj/NB Budget data. 

This can be accessed through Accounting » Organizational Budgeting » Controls and Utilities » 
Mass Upload Project Budgets to Organization Budgets. 

 

 
Three utilities to mass integrate the Project Budgets and Org Budgets have been combined in the menu 
item ‘Mass Upload Project Budgets to Organization Budgets’: 

1. Update Org Labor from Project Labor 

2. Update Org Non-Labor from Project Non-Labor 

3. Update Org Revenue from Project Revenue   

These three integration options are also available within the individual Org Budgets.  Labor and Non-
Labor can be updated without updating the Revenue. 
 
When the Configuration setting ‘Org Budget Revenue Calculation’ is set to either:  

a) ‘Project Budget Revenue’ or  

b) ‘Project Plus Org Revenue Adjustment’  
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the ‘Mass Upload Project Budgets to Organization Budgets’ Revenue option becomes available. 
If the configuration ‘Org Revenue Calculation’ is selected, only the ‘Update Org Labor from 
Project Labor’ and ‘Update Org Non-Labor from Project Non-Labor’ mass updates are available. 
 

Another update for this feature is that the menu choices for Populate Org Budget Labor Utilization with 
Project Budget Labor from CU22 and Utility to Update Org Non-Labor from Project Non-Labor from 
CU15 are now gone. They are now included as subtasks in the new CU25 Mass Upload Project 
Budgets to Organization Budgets.   
 
The Labor, Non-Labor and now ‘Revenue’ are upload choices from that one screen as subtasks.  The 
Labor and Non-Labor can be run on their own, but they must be run if the user wants to run update 
revenue. 
 
Requirements: 

 A prerequisite for processing Update Org Revenue from Project Revenue is that Update Org 

Labor from Project Labor and Update Org Non-Labor from Project Non-Labor have first 

been processed.  

The system will ‘flag’ that they have been run by checking the appropriate boxes in the header of 
the screen.  The user can then proceed to Update Org Revenue from Project Revenue. 

 To view the last updates, the user can access the subtasks and then access the View Uploaded 

Labor/Non-Labor/Revenue without processing the updates.   

 The Update process will overwrite previous results. 

 

User Steps: 

1. Choose Fiscal Year, Organization either All or Range, Budget Type either Proj or Proj/NB, 
Project Status either Completed or Approved (this is the minimum status of the Project 
Budgets to include). 

 

2. Choose Update Org Labor from Project Labor or Update Org Non-Labor from Project Non-Labor 
(Update Org Revenue from Project Revenue cannot be updated until Labor and Non-Labor have 
been updated).   

In the Labor screen, the check box in the Upload column at the top level of the Org defaults to 
checked.  In the Non-Labor screen, the bottom level of the Org defaults as checked.  

Expand the Org by clicking on the ‘+’ sign and review.   
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Uncheck any Orgs that are not to be updated.   
Note: If there is no Org Budget the Org will be listed under ‘Org Budget – Missing’. 

 

3. Click the Update button.  To view the result set, highlight a row on the Update Org Labor from 
Project Labor screen and click the subtask View Uploaded Labor (the title of the subtask 
changes in the other update screens to Non-Labor or Revenue). 

 

 
 

4. When the Labor and Non-Labor have been updated and the system checks the box in the 
header, then you can proceed to Update Org Revenue from Project Revenue. 

 

 
 

5. Click the Update Org Revenue from Project Revenue subtask.  You can expand each row, the 
lowest level of the Org defaults to checked in the ‘Upload’ column.  Uncheck any Orgs not to be 
updated.  Then click the ‘Update’ button.  Click the subtask View Uploaded Revenue to review 
the results. 

6. In the screen header, all three system check boxes are now checked. 
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To access Update History without running the processes: 

To view the last updates, the user can access the subtasks and then access the ‘View Uploaded 
Labor/Non-Labor/Revenue’ without processing the updates.   

Important: 

Prior to running this utility, it is suggested that you execute the following reports to ensure that all of your 
project budgets (or EACs) AND your non-backlogs have been completed 

Projects – Project Budgeting > Top Level (All Projects) Reports > Budget/EAC Status (APT1) 

Non-Backlog projects – Project Budgeting > Proposal Budgets > Non-Backlog Budget Revenue Summary 
(Rev/Cost) (NPT2) 

Note: Access to this application should be limited by security as the function has the ability to overwrite 
information in the Organization Labor Utilization budgets. 

Audit/History Report for Populate Org Budget with Proj/NB Budget 
Revenue 
Released August 1, 2017 

An Audit/History Report is now available as a ‘view’ in a subtask View Uploaded Revenue within the 
revenue update screen.  It is not necessary to run the processes in order to see the last update. 

Click the View Uploaded Revenue subtask to review the report before committing the revenue. 

Multi-Company Budget Functionality 
Released August 1, 2017 

As Costpoint is a multi-company, the same capability was added in B&P so that when a user switches 
companies, they can access different data.  Burdening uses the templates of that Costpoint company's' 
pools. 

Note: When switching CP Companies, their functional currencies can be different. Multicurrency 
functionality is currently not included in B&P, so budgets entered are assumed to be in the functional 
currency of the CP Company. 

Populate Org Budget Revenue with Project/Non-Backlog Revenue 
Released June 2017 

This functionality is not a separate utility but a process within the Org Budget when the Update process 
is run or the new Mass Revenue Update is run. 
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The Administration Controls now have 2 new options for users: 

 
1. A new field Org Budget Revenue Calculation was added to the Organization tab of Configuration 

Settings (MAM10). You can select from either Org Revenue Calculation (This is the current 
functionality), Project Budget Revenue or Project Plus Org Revenue Adjustment.  
 
If the global setting is for Project Budget Revenue, parts of the Organization Budgets/Outlooks 
subtask Revenue Setup are disabled.   
 

 
 

 The global setting for ‘Budget Revenue Org Method’ is disabled if the Org Revenue is to come 
from the Project Budget. The Budget will follow the Costpoint revenue setup for 'Owning' or 
'Performing' Org. However, budget reports can be run by either Org method. 

A new addition to this functionality is Revenue Adjustment subtask. This subtask can be found 
under the Revenue Setup subtask in Org Budgeting. 

The Revenue Adjustment subtask is only available if the Org Budget Revenue Calculation item 
in MAM10 was set to use Org Revenue Calculation or Project Plus Org Revenue Adjustment. 

 
 

2. When the system is set to Populate the Org Budget Revenue from the Project/Non-Backlog 
Budgets, the Organization Budgets/Outlooks screen Update function populates the Org Budget with 
budgeted revenue data for the Org from the Project Budgets.   
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Each time the Update Org Revenue from Project Revenue subtask is updated, the budget revenue 
will be updated and overwritten. 

Before the Commit function, the user must access the two subtasks in the Org Budget or the Mass 
Revenue Update screen to run the Update Org Non-Labor from Project Non-Labor and Update 
Org Labor from Project Labor. 

There will be no ‘Plugs’ when Project Budget Revenue is used.   

 

To Populate Org Budget Revenue with Project/Non-Backlog Revenue, complete the following 
steps: 

1. In Organization Budgets/Outlooks, select the Org and Fiscal Year and click the execute icon from 
the toolbar.   

The Outlook ‘status’ needs to be ‘working’. 

2. Click Revenue Setup subtask.   

Note that Fee Rate and Default Rev Acct fields will be unavailable. 

3. Enter Default Direct Labor and Indirect Labor Accounts. 

4. In Revenue Type, select Update Proj Rev or Update Proj/NB Rev. 

5. Setup Revenue Adjustments if required. 

 

6. Access Update Org Labor from Project Labor and click Update.   

The Upload box will be checked.  

7. Close the screen. 

 

 
8. Access Update Org Non-Labor from Project Non-Labor and click Update.   

The ‘Upload’ box will be checked.  
9. Close the screen. 
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The screen now displays as follows: 

 

After the first upload, the ‘Revenue Type’ drop-down box is set to ‘read only’ 
10. Access Update Project Revenue and click Update.   

The ‘Upload’ box will be checked.  
 

11. Close the screen. 

 

 
The Setup is now Complete and the Commit button is now available.   
Note that before committing, click the subtask History in order to review the result set. 
 

12. Click Commit to update the Org Budget with the Project Budget Revenue. 

Populate Org Budget Labor Utilization with Project Budget Labor 
Released April 2017 

Users now have the option to port over all labor budgets from the project budgets (and non-backlog), into 
the Org Budget Labor Utilization tab (Budget only). 

You can run this process more than once but keep in mind that if it is run again, all previous uploads and 
subsequent modifications will be overwritten by the new upload. 

Mark the Upload check box to choose which rows will be included in the upload.  

When you click Update the data is copied to the Org tables and user can view in Organization/Outlook 
Budgets, Labor Utilization tab. 

Important 

Prior to running this utility, it is suggested that you execute the following reports to ensure that all of your 
project budgets (or EACs) AND your non-backlogs have been completed 

 Projects  –  Project Budgeting > To Level (All Projects) Reports > Budget/EAC Status (APT1) 
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 Non-Backlog projects – Project Budgeting > Proposal Budgets > Non-Backlog Budget Revenue 

Summary (Rev/Cost) (NPT2) 

Note: Access to this application should be limited by security as the function has the ability to overwrite 
information in the Organization Labor Utilization budgets. 

This new utility can be found in Accounting » Organizational Budgeting » Controls and Utilities » 
Update Org Labor from Project Labor. 

 

Utility to Update Org Non-Labor from Project Non-Labor 
Released September 2016 

Users now have the option to port over all non-labor data from the project budgets and non-backlog 
budgets into the latest Org Budget’s Non-Labor dollar tab. 

Note: Access to this application should be limited by security as the function has the ability to overwrite 
information in the Organization Budgets and/or Outlooks. 

This new utility can be found in Accounting » Organizational Budgeting » Controls and Utilities » 
Update Org Non-Labor from Project Non-Labor. 
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Project Budgeting  

Import Multiple Budgets/EACs from Excel 
Released May 2018 

A new Projects » Project Budgeting » Controls and Utilities » Import Budget/EACs from Excel utility 
was added that enables you to import multiple project budgets and EACs from Excel and then upload 
them to the Project Budgets/EACs application. 

The Excel template has been formatted by Deltek for this purpose. The template, available from the Excel 
Template subtask, includes column headings that correspond to fields within the Project Budgets/EACs 
application. 

 

The Import Budget/EACs from Excel application provides users with the capability to perform the following 
functions: 

 Download the pre-formatted Excel template. 

 Upload data from Excel to Budgeting & Planning. 

 Select error reporting and duplication parameters, and after the upload is finished, review the 
results in the Upload Report subtask prior to uploading the data to the Project Budgets/EACs 
application. 

 Review errors using the Error Report subtask. 

 Commit multiple budgets simultaneously to Budgeting and Planning. 

Administrator Prerequisites 

Information in this section applies primarily to system administrators.  

 Users must save the completed template as an .xml data file prior to upload.  

 

 Users must save the .xml file to a specified Alternate File Location for the application to access it 
for processing. If you have not yet configured the Alternate File Location, see online help for 
Administration » System Administration » File Management » Manage Alternate File 
Locations. See also the note in the Preparing Your Data for Upload section below. If a common 
network location will be used for this purpose that location should be made known to users of this 
application.  

 An Import Budget/EACs from Excel Commit Flag Default check box was added to Admin » 
Budget Administration » Administration Controls » Configuration Settings (MAM10) » 
Project tab. When you select this option, the Commit check box on the Upload Report subtask is 
selected by default, but the user can change the status.  

Note: Previously, you could only import projects one at a time using the Import Budget/EAC from 
Scheduling App (BPU1, BPU3, BPU5, NPU1) screen. The ability to import multiple project 
budgets/EACs is presently limited to Excel. 

Note: If the .xml file extension does not exist in in the File Upload Limits table of the Admin » 
System Administration » System Administration Controls » Configure System Settings screen, it 
must be added. 
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Preparing Your Data for Upload 

To upload your data into the Import Budget/EACs from Excel utility, you must start by entering your 
project budgets/EACs into a Deltek-formatted Excel template. A link to the template is available from the 
Excel Template subtask on the Import Budget/EACs from Excel screen. 

To download the Excel template, complete the following steps: 

1. Click Projects » Project Budgeting » Controls and Utilities » Import Budget/EACs from Excel to 
display the utility. 

2. Click the Excel Template subtask link. 

3. In the Excel Template subtask, copy the URL and paste it into a web browser. 

4. Save the template to your specified location. 

To finalize the template for use in the Import Budgets/EACs from Excel utility, complete the 
following steps: 

1. Enter budget/EAC data in the spreadsheet. 

2. In Excel, save the template as an .xml file type. If you are unfamiliar with this process, refer to the 
Excel online help. 

 

Upload and Process Your Data 

In the Import Budget/EACs from Excel screen, you will set validation parameters, select error report 
settings, and then select the location where the .xml file was saved. 

 

Note: To be uploaded within the Import Budget/EACs from Excel utility, the .xml file must be available 
in a preconfigured location within Costpoint, referred to as an Alternate File Location.  

When you save the template as an .xml file, you must either save it to the Alternate File Location, or 
copy it there using File Upload on the Process menu. If you do not know the Alternate File Location, 
check with your System Administrator. 
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To import multiple budgets/EACs, complete the following steps: 

1. From the If a Budget/EAC already exists, do you want validations to create an error when 
Uploading File? drop-down list, choose one of the following: 

 Yes — If a budget/EAC already exists an error will result. 

 No — If you select this option, proceed to Step 2.  

2. From the If a Budget/EAC already exists, do you want to drop-down list, choose one of the 
following 

 Overwrite entire Budget/EAC — For Budgets, the budget for the entire period of 
performance, including past, current and future periods, will be overwritten by the .xml 
uploaded file 

o If the existing Budget/EAC status is Complete, Incomplete, or Working, a 
Working version is created with the same version number. The old copy of 
the version remains available to view until the new Working version is 
committed. 

o If the existing Budget/EAC is ‘Approved,’ a new Working version will be 
created with a new version number.  

This field is disabled if you select Yes from the If a Budget/EAC already 
exists, do you want validations to create an error when Uploading File? 
drop-down list. 

 Append current and future periods — For Budgets/EACs, the current and future 
period Budget will be updated by the .xml upload. Prior Periods will not be changed. If 
an .xml file is uploaded with Prior Period changes, then an error is created during 
validation 

3. From the If validation finds an error drop-down list, choose one of the following: 

 Fail all – view items in error report - All .xml lines will fail if a single error is found. 

 Upload passes – view failed items in error report - Only .xml line items not included 
in the error report are uploaded, with the rest displayed in the error report. 

4. Upload the .xml data using one of the following methods: 

 In the Location field, click  to select the location from the list of Alternate File 

Locations already designated within Costpoint, and in the Name field, click  to select 
the file.  

 On the Process menu, click File Upload, and in the File Upload Manager screen, click 
Browse to select the .xml file. 

5. Click Upload File. 

6. If errors occur, click the Error Report subtask link to view them. 

Reviewing Errors and Uploading Using the Upload Report Screen 

After the .xml file is successfully uploaded in the Import Budget/EACs from Excel screen, it is 
automatically processed. Depending on validation settings, the Budgets/EACs that did not contain errors 
are either uploaded immediately to the Project Budgets/EACs application as budgets with a Working 
status, or all the budgets/EACs fail if any errors exist. 
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The Upload Report subtask displays the budgets/EACs that were successfully uploaded. From that same 
subtask, you can also commit selected budgets/EACs. After you commit, the status of the uploaded 
budget/EAC in the Project Budgets/EACs application changes from Working to Incomplete. 

You can review error messages on the Error Report subtask. Using the information available on this 
subtask as a guide, you can make corrections to your original entries in the Excel template, and then re-
run the process until you have successfully imported all Budgets/EACs into the Project Budgets/EACs 
application. 

Error Report Subtask: Review Upload Errors 

After the budgets and EACs in the .xml file are processed, any of those that failed display on the Error 
Report subtask. 

Fields that display on the Error Report subtask are identical to those in the Excel template. 

The Error Report Subtask table displays ten columns to help you identify and address budget errors: 

 Project ID/Period End Date 

 ID Type 

 ID 

 Pool Org ID 

 Account ID 

 PLC 

  Rate 

 Hours 

 Amount 

 Detailed Error Message 

 

 

Upload Report Subtask: Review the Budget Date Upload Results 

You can use the Upload Report subtask to view the result set after the upload completes. The subtask 
table includes five columns: 

 Project ID – this column displays one row per Project ID uploaded. 

 Errors –  this column displays one of two values: 

 Yes indicates that the project budget has partially uploaded but has errors. 

 No indicates that the project budget has completely uploaded.  

 

 Budget Type – This column displays the budget type (BUD or EAC). 

Use the Expand All and Collapse All buttons to maximize and minimize the error list. 

Note: The Error Report subtask is operative only if users have selected the Upload 
passes – view failed items in error report option in the If validation finds an error 
dropdown list. The other available option is for all to fail on validation error 

If you forget your username or password, you can click the Need Help? button on 
the login screen for help. 
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 Version – This column displays either the version number of the Working 
budget/EAC that will be overwritten or the version number of the newly created 
budget/EAC that will be committed in the Upload Budgets/EACs process. 

 Commit – This column displays a check box that is selected, or left clear, by default. 
Though the default setting is specified in the Configuration setting, it can be modified 
here. 

 Click Upload File to update budgets and EACs. 

Requirements 

The enhancement requires cp711_bnp_common_006.zip. 

Budget by Resource 
Released May 2018 

The Add/Edit/Delete Assignments subtask in Budget By Resource now includes a Type column 
where you can select the type of budget.  After you click New in the subtask, you will have to select the 
Budget Type. Choose from Project, Proposal or Non-Backlog budget type. 

Also, the Source column now displays BUD (Project Budget), EAC, PRP (Proposal) or NBL (Non-
Backlog). 

A Query was added to the result set screen to further filter the results.  The query criteria are the column 
headers. 

Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module Application ID Application Name Application File 

Projects Project 
Budgeting 

bnp_bgmbpir.htm Budget by Resource cp711_bnp_common_008.zip 

Update to Project/Budget/EAC Mass Utilities  
Released April 2018 

A new Mass Update Process was added to the application that enables you to mass update Budgets and 
EACs. 

For both Budgets and EACs, you can create new EACs from approved versions, 
Approve/Complete/Commit/Delete, and update the staff escalation % for working versions. 

To open the utility, click Projects » Budgeting » Controls and Utilities » Project Budget/EAC Mass 
Utilities. 

Select an option under Budget Type, and under Budget Status, select the current budget status you want 

to update. You can optionally include inactive projects in your search results. Click  to display the 
results in the Select Budgets/EACs table, where you can refine the results further using the Query 
function.  

Information displayed includes the following:  

 Type – Reflects the option you selected in the header. 

 Project - The Project ID of the Project Budget/EAC.  
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 Ver – Displays the latest version of the Budget/EAC.  

 Status – Reflects the option you selected in the header.  

 Last Closed Period – Displays the Last Closed Period when the EAC was created.  

 Escalation - The Escalation % used in the Budget/EAC for resource costs. 

 Current EAC Version - For Budgets, indicates whether an EAC exists. 

In the table, select the rows you want to update, and under Mass Update Process, click the process you 
want to apply. Note that the process buttons are either active or inactive depending on the Budget Status 
option you selected, and for working budgets/EACs, you can enter an escalation % value in the Percent 
field. 

Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module Application ID Application Name Application File 

Projects Project 
Budgeting 

BNP_BGMBPMU Project Budget/EAC 
Mass Utilities 

cp711_bnp_common_007.zip 
cp711_bp_bnp_bgmbpmu_001.
zip 

Vendor Employees as Resources 
Released April 2018 

Users can now select Vendor Employees as resource type from the following applications: 

 Project Budgets/EACs 

 Budget by Resource (BPIR) 

 Project Proposals (NPI4) 

 Project Non-Backlog Budgets (NPI7) 

In Budget by Resource (BPIR), this option is available through the Resource Type drop-down menu. 

 

 
In Project Budgets/EACs, Project Proposals (NPI4) and Project Non-Backlog Budgets (NPI7), this option 
was added to the Subcontractor/Consultant/Subcontractor Hours and Consultant Hours subtask 
link.  

Users can access this additional resource when they click New and select from the ID Type drop-down 
menu. 
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Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module Application ID Application Name Application File 

Projects Project 
Budgeting 

BNP_BGMBPMU Project Budget/EAC 
Mass Utilities 

cp711_bnp_common_007.zip 

Projects Project 
Budgeting 

BNP_BGMBPIR Budget by Resource 
(BPIR) 

cp711_bnp_common_007.zip 

Projects Project 
Budgeting 

BNP_NBMNPI4 Project Proposals 
(NPI4) 

cp711_bp_bnp_nbmnpi4_004.zip 

Projects Project 
Budgeting 

BNP_NBMNPI7 Project Non-Backlog 
Budgets (NPI7) 

cp711_bp_bnp_nbmnpi7_004.zip 

Advanced Search 
Released April 2018 

Due to the addition of Vendor Employees, the Advanced Search functionality was also added to the 
Consultant Hours and Subcontractor Hours subtasks of Project Budgets/EACs. Use this feature to 
select resources according to skills or credentials, or other criteria, such as supervisor or GLC. 

Click the Advanced Search subtask link to search for multiple resources using other criteria. 
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After you click Find Resources, the results display in the Resources table 

 

Click Add Resources, to add the results to the subtask, either Consultant Hours or Subcontractor Hours. 

This same functionality is also available in the following applications within Project Budgeting » 
Proposal Budgets: 

 Project Proposals (NPI4)  

 Project Non-Backlog budgets (NPI7) 

Requirements 

The enhancement requires the following:  cp711_bp_bnp_nbmnpi4_003.zip. 

Resource Planning 
Released August 2018 

The Budget by Resource application was renamed and moved to its own module Resource Planning. 

Released March 2018 

Budgeting & Planning includes a new resource planning application (Budget by Resource) that enables 
you to select a resource, or a team of resources, and then assign the selected resources to multiple 
budgets at the same time.   

Functionality is currently limited to employee resources, but vendor employees will be added in a future 
release. 

You can assemble team resources by name, generic staff, or text entry, or use new Advanced Search 
functionality to select resources according to skills or credentials, or other criteria, such as supervisor, 
organization ID, or GLC. 

Other key abilities include: 

 Save selected teams for future use.  

 View assignment utilization and hours. 

 View all projects to which a resource is assigned. 

 Add, edit, or delete project assignments. 

 Update Project Budgets/EACs with budget assignments. 

 Commit assigned budgets. (Includes an optional default configuration setting.)  

Configuration Settings 

See “Budget By Resource Configuration Setting” below for more information.  

Other Related Enhancements 

The Advanced Search functionality described in these release notes was also added to the Staff Hours 
subtask of the following applications: 
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 Project Budgets/EACs  

 Project Non-Backlog Budgets (NPI7) 

 Project Proposals (NPI4) 

In the above applications, the Advanced Search subtask only displays if the budget/EAC has a status of 
Working. In all other aspects, the feature performs as described in this document. 

Budget Resource Planning 
To open the application, click Projects » Project Budgeting » Budget/EAC Processing » Budget By 
Resource.  

From the Budget By Resource screen, you can select individual resources by type or find resources using 
search criteria. To get started, you must first select the assignment date range for the budget period you 
want to plan.  

Refer to the screen images below to learn more about using this planning tool.  

 

Select a Resource by Type 

 

Select Resources Using Advanced Criteria, Modify Resource Hours, and Update Project 
Budgets/EACs 

Click the Advanced Search subtask link to search for multiple employee resources using other criteria. 
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After you click Find Resources, the results display in the Resources table. 

 

After you click Add Resources, selections are added to the Selected Resources table. 

 

After you click Add/Edit/Delete Assignments, you can update hours on existing budgets assignments, 
add new budgets, or delete budgets.  

 

For a complete listing and description of all the fields that display in the Add/Edit/Delete Assignments 
subtask, see the online help. The following is a partial list only.  
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Column/Row Heading Description 

Project ID This non-editable field displays the Project ID number. The same Project ID 
may display multiple times if the resource is used under different account IDs, 
Org IDs, or PLCs. 

Row Headings  

The last three rows of the first column, which are colored yellow, display totals. The totals, which vary by 
column, always reflect the From/To period you selected in Assignment Range at the top of the screen.  

Assignment Total Assignment hours are the hours assigned to the resource within the selected 
assignment range.  

Assignment totals display in the following columns:  

 Assignment Hours – Displays the total number of hours the resource has 
been assigned.  

 Assignment Utilization % – Displays the total utilization % the resource 
has been assigned.   

 Period (dated column) – Displays the total hours assigned to the resource 
for a specific period within the selected date range 

Available Hours Available hours are the hours available to for resource within the selected 
assignment range.  

Available hour totals display in the following columns.  

 Assignment Hours – Displays the total number of hours the resource has 
available.  

 Assignment Utilization % – Displays the % the assignment hours 
represent.   

 Period (dated column) – Displays total hours the resource has available 
for a specific period within the selected date range. 

Remaining Hours This row represents the difference between the Available Hours and the 
Assigned Hours, which is same calculation that is used to arrive at the 
Utilization %. 

Commit Select the check box to commit the budget when you click Assign or Assign 
All Resources. 

If the Resource Budget Commit Flag Default setting in Configuration Settings 
(MAM10) is selected, this check box is selected by default, and budgets with a 
Status of Working are automatically committed when you click Assign, but the 
check box can be edited in this screen. 

That version of the budget will not be set to Approved, and you must approve it 
from the Project Budgeting/EACs application. 

Assignment Start 
Date 

This column displays the assignment start date as entered in the Assignment 
Range date fields. 
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Column/Row Heading Description 

Assignment End Date This column displays the assignment end date as entered in the Assignment 
Range date fields. 

Assign Resource Hours to Project Budgets/EACs 

After you finish planning hours for the selected resource, you can save your changes and continue 
planning hours for other resources, or before proceeding, you can update staff hours in the Project 
Budgets/EACs application with the current resource assignments by clicking Assign on the 
Add/Edit/Delete Assignments subtask.  

To save changes without assigning them, click  on the global menu and then click Close on the 
Add/Edit/Delete Assignments subtask.  

 

After you finish planning hours for all resources, click Assign All Resources on the Selected Resources 
table to update process your changes and update staff hours in the Project Budgets/EACs application. 

Budget/EAC Processing Rules 

When the Project Budgets/EACs application is updated, the status of an existing budget changes, and if 
no budget already exists, one is created. Committing the budget also affects the status.   

 

During processing, budgets are updated according to the following rules: 

 If no budget exists, a new Working Budget is created. If the Commit check box was selected, an 
Incomplete Budget is created. 

 If a Working Budget/EAC exists, it is updated. If the Commit check box was selected, an 
Incomplete Budget with same version number is created.  

 If an Incomplete Budget/EAC exists, it is updated. If the Commit check box was selected, an 
Incomplete Budget with same version number is created. Budget & Planning first creates a 
Working Budget to add the entry, and if Commit is selected, it then creates a budget with a status 
of Incomplete with the same version number. 

 If a Complete Budget/EAC exists and the Commit check box was selected, an Incomplete 
Budget/EAC is created. If the Commit check box was clear, a new Working budget/EAC is 
created with the same version number. 

 If an Approved Budget/EAC exists and the Commit check box was selected, a new Working 
Budget/EAC is created. If the Commit check box was clear, a new Working budget/EAC is 
created with the same version number. 

Note: The Add/Edit/Delete Assignments table and the Selected Resources table both include a status 
column that indicates whether or not a resource record has been saved. 

Note: Depending on configuration, the Commit check box in the Add/Edit/Delete Assignment subtask 
will be either selected or clear by default. If it is not selected, the budget must be committed from the 
individual project budgets. 
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Save Teams 

Prior to closing the application, you can use the Save Team functionality to save the selected group of 
resources as team, which you can select in future planning sessions.  

To save a team, complete the following steps: 

1. In the Teams field, enter a name for the team. 

2. Click Save Team. 

To search for a previously saved team, in the Teams field, click  to select the team using Lookup or 
enter the team name. 

Advanced Search 
Released March 2018 

The Advanced Search functionality which was developed for the Budget by Resource application was 
also added to the Staff Hours subtask of the following applications: 

 Project Budgets/EACs  

 Project Non-Backlog Budgets (NPI7) 

 Project Proposals (NPI4) 

In the above applications, the Advanced Search subtask only displays if the budget/EAC has a status of 
Working. In all other aspects, the feature performs as described in this document. See “Select Resources 
Using Advanced Criteria…” in the Resource Planning feature description to learn more about using this 
feature. 

Budget By Resource Configuration Setting  
Released March 2018 

A Resource Budget Commit Flag check box was added to the Projects tab of Admin » Budget 
Administration » Administration Controls » Configuration Settings (MAM10). When this option is 
selected, the Commit check box in the Add/Edit/Delete Assignments subtask will be selected by default, 
but the user can change the status.  

When this check box is selected, the budget is committed when the user clicks Assign, or clicks Assign 
All Resources. If it is not selected, the user must instead commit the budget from the individual project 
budgets. 

Ability to Add Employee Record to Other Direct Cost 
Released March 2017 

You can now enter employee records using the Other Direct Cost sheet in the Project Budgets/EAC 
screen. 

To add an employee record to, do the following steps: 

1. Go to Projects » Project Budgeting » Budget/EAC Processing »Project Budgets/EAC. 

2. Enter a valid Project ID. 

3. Click Execute icon. 

4. Click Other Direct Costs sheet. 
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5. Click New. 

6. Enter the new employee record either in hours or costs. 

Updates to SPA5 and SPA8 
Released November 2016 

Column headers and report names were updated to better explain what information is displayed in each 
column of the report. 

The following changes were made: 

1. Updated Column Headers  

Before Now 

Contract ITD Incurred ITD 

Commitments Pending 

Committed ITD ITD Plus Pending 

 

2. Renamed the hyperlink at the bottom of the Project Status (SPA5) 

3. The link to Commitments Detail is now called Pending Charges Detail. 

4. The associated “commitments” report which was formerly called ‘Purchase Commitment 
Detail (SPA8) is now called Pending Charges (SPA8). 

5. The report title/header was changed to reflect the new name 

Update to MAM2, BOM5, BPM5 
Released November 2016 

You can now view the generic staff usage and option was added to prevent users from editing values for 
generic staff that are in use except for the accrual rate. 
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Real-Time Visibility Into Unposted Labor and Non-Labor 
Released August 2016 

In order to see the impact of commitments on a project’s performance, the Project Status Report (SPA5) 
will calculate and display revenue and profit on the commitments.  

The PSR was also extended to show a true ITD on the project by adding columns to combine the 
commitments with the Contract ITD actuals (Committed ITD), and finally, compare the Committed ITD to 
the ITD Budget (Variance ITD). Users of CER will also have this data available for reporting in Costpoint 
Enterprise Reporting. 

Added Revenue on Commitments 
Released August 2016 

Project Status Report (SPA5) now calculates and displays revenue on committed costs in the 
commitments column. This enables users to view how existing projects are affected.   

Note: Revenue will only calculate if a valid record exists for the project in the EPROJ_REV_SETUP table, 
initially populated from Costpoint. 

You now have the option to select Revenue from the Details group box. 

 

Added Two New Columns in PSR Summary Detail 
Released August 2016 

Two new columns were added for addition information. The Committed ITD column was added to display 
Contract ITD plus Commitments detail while the Variance ITD column displays Committed ITD less 
Budget ITD information. 
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Added Commitments Revenue to CER Tables 
Released August 2016 

Revenue calculated on the Project Status Report (PSR) Commitments column was also added to the 
CER Report tables so users can utilize this information for their report. 

Ability to Modify Organization ID  
Released May 2016 

For this version, the Organization ID field was added in the Create Proposal or Non Backlog (NPI1, NPI3, 
NPI6) screen.  

This enables you to change/modify the default Organization ID when you want to clone proposal from 
existing proposal or when you want to clone from non-backlog project budget to proposal.  

Source: Proposal 
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Source: Non Backlog 

 

Set Revenue Amounts for Fixed Price Contracts 
Released Dec. 2015 

A Revenue screen was added, where you can now enter a specific revenue amount for fixed price 
contracts. Use this screen to manage fixed price revenue and revenue adjustments for project budgets.  

To enter or adjust a revenue amount, complete the following steps:  

1. In the Projects domain, go to BNP Project Budgeting » Budgeting/EAC Processing » Project 
Budgets/EACs. 

The Project Budgets/EACs screen displays. 

2. In Project ID, select the project ID, and in the Project Budget Status table, select the budget.   

3. Click the Revenue Setup/Ceilings subtask link. 

4. To enter a fixed rate, select the Use Fixed Revenue Amount as Total Revenue check box, and 
in the Fixed Revenue Amount column, enter the amount.   

 

To later make adjustments to fixed rate you have already established, select the Override 
Revenue Adjustments from Accounting System check box, and enter the new amount in the 
Revenue Adjustment column. 

Support for Project Budgets that Exceed 130 Periods 
Released Dec. 2015 

Previous versions of B&P can only support up to 130 periods. Today, B&P 7.0 has the ability to support 
project budgets that exceed 130 periods. 
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Full Support for Indirect Project Budgeting 
Released Dec. 2015 

B&P 7.0 now offers full support for Indirect Project Budgeting by having the ability to recognize Project 
Account Groups for indirect projects, as well as the ability to create budgets that exceed 130 periods.  

B&P7.0 also supports mapping of indirect project accounts using Manage Project Budget Sheet Account 

IDs (MAP4, MAP5). Use this screen to override the default indirect account IDs for any sheet (tab) in the 
budgeting module. Indirect Project Account Groups merges with the overrides, giving the user an updated 
list of Account IDs per sheet in the budgeting module. 
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Appendix A: For Additional Information 

Deltek Support Center 
The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support 
Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 

 Search for product documentation, such as release notes, install guides, technical information, 
online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 
Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Initiate a Chat to submit a question to a Customer Care analyst online 

 

Access Deltek Support Center 

To access the Deltek Support Center:  

1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

 

Attention: For more information regarding Deltek Support Center, refer to the online help available 
from the Web site. 

Note: If you forget your username or password, you can click the Need Help? button on the login 
screen for help. 

https://deltek.custhelp.com/


 

 

About Deltek 
Better software means better projects. Deltek is the leading global provider of enterprise software and 
information solutions for project-based businesses. More than 23,000 organizations and millions of users 
in over 80 countries around the world rely on Deltek for superior levels of project intelligence, 
management and collaboration. Our industry-focused expertise powers project success by helping firms 
achieve performance that maximizes productivity and revenue. www.deltek.com 

http://www.deltek.com/
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